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1 Welcome
Welcome to the OMEGASCOPE™ PC Oscilloscope software.

With an OMSP-2000/3000/4000 Series device, OMEGASCOPE™
turns your PC into a powerful PC Oscilloscope  with all the features
and performance of a bench-top oscilloscope  at a fraction of the
cost.

How to use this manual
What's new in this version?
Using OMEGASCOPE™ for the first time

    

M5064-1111 : 2012-02-27, S/W 6.6.1
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2 OMEGASCOPE™ overview
Higher performance

Faster capture rates, making it easier to see fast-moving signals
Faster data processing
Better support for the latest OMEGASCOPE™ USB oscilloscopes

Improved usability and appearance

Clearer graphics and text
Tool tips and help messages to explain all features
Easy point-and-click tools for panning and zooming

Features

The latest Windows .NET
technology enabling us to
deliver updates more quickly

Multiple views  of the same
data, with individual zoom
and pan settings for each
view

Custom probes  manager
to make it easy for you to
use your own probes and
sensors with OMEGASCOPE™

Advanced triggering
conditions  including pulse,
window and logic

Properties sheet
displaying all settings at a
glance

Spectrum mode  with a
fully optimized spectrum
analyzer

Per-channel lowpass filtering Math channels  for creating
 mathematical functions of
input channels

Reference waveforms  for
storing copies of input
channels

Arbitrary waveform designer
 for oscilloscopes with a

built-in arbitrary waveform
generator

Rapid trigger mode  to
capture a sequence of
waveforms with the
minimum possible dead time

Windows Explorer integration
 to show files as pictures

and convert to other formats

Command-line options  for
converting files

Zoom overview  for rapidly
adjusting the zoom to show
any part of the waveform

Serial decoding  for RS232,

I2C and other formats, in real
time

Mask limit testing  to show
when a signal goes out of
bounds

Buffer navigator  for
searching the waveform
buffer

Alarms  to alert you when
a specified event occurs
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3 Introduction
OMEGASCOPE™ is a comprehensive software application for OMSP-2000/3000/4000
Series PC Oscilloscopes. It creates a virtual oscilloscope, spectrum analyser and
multimeter on your PC.

OMEGASCOPE™ supports the following scope devices:

OMSP-4000 Series
OMSP-3000 Series
OMSP-2000 Series

OMEGASCOPE™ runs on any computer with Windows XP SP2 or later, Windows Vista
or Windows 7. (See System requirements  for further recommendations.)

Contact information
How to use this manual

How to use OMEGASCOPE™

Getting started: see using OMEGASCOPE™ for the first time , and
OMEGASCOPE™'s Features.
For further information: see descriptions of Menus  and Toolbars , and the
Reference  section.
For step-by-step tutorials, see the "How to " section.

3.1 Trademarks
Windows is a registered trade mark of Microsoft Corporation. OMEGASCOPE™ is a
trademark of Omega Engineering, Inc.

3.2 Contact information
Address: Omega Engineering, Inc.

One Omega Drive
P.O. Box 4047
Stamford, CT 06907
USA

Phone:
Fax:

203-359-1660
203-359-7700

Technical support email:
Sales email:

das@omega.com
sales@omega.com

Web site: www.omega.com

3.3 How to use this manual
If you are using a PDF viewer to read this manual, you can turn the pages of the
manual as if it were a book, using the Back and Forward buttons in your viewer.
These buttons should look something like this:

Back

Forward

You can also print the entire manual for reading away from your computer. Look for a 
Print button similar to this:

5

3

3
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Print

For your first introduction to OMEGASCOPE™, we suggest that you start with these
topics:

Using OMEGASCOPE™ for the first time
Oscilloscope basics
PC Oscilloscope basics
OMEGASCOPE™ basics

6

7
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3.4 System requirements
To ensure that OMEGASCOPE™ operates correctly, you must have a computer with at
least the minimum system requirements to run one of the supported operating
systems, as shown in the following table. The performance of the oscilloscope will be
better with a more powerful PC, and will benefit from a multi-core processor.

Item Absolute
minimum

Recommended
minimum

Recommended
full specification

Operating system Windows XP SP2
Windows Vista

Windows 7

Windows XP SP2
Windows Vista

Windows 7

Windows XP SP2
Windows Vista

Windows 7

Processor
As required 
by Windows

300 MHz 1 GHz

Memory 256 MB 512 MB

Free disk space* 1.5 GB 2 GB

Ports USB 1.1 compliant port USB 2.0 compliant port

* The OMEGASCOPE™ software does not use all the disk space specified in the table.
The free space is required to make Windows run efficiently.
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4 Using OMEGASCOPE™ for the first time
We have designed OMEGASCOPE™ to be as easy as possible to use, even for
newcomers to oscilloscopes. Once you have followed the introductory steps listed
below, you will soon be on your way to becoming a OMEGASCOPE™ expert. 

1. Install the software. Load the CD-ROM that is included with your scope
device, then click the "Install Software" link and follow the on-screen
instructions.

2. Plug in your scope device. Windows will recognise it and prepare your
computer to work with it. Wait until Windows tells you that the device is
ready to use.

3. Click the new OMEGASCOPE™ icon on your Windows desktop.

4. OMEGASCOPE™ will detect your scope device and prepare to display a
waveform. The green Start  button will be highlighted to show that
OMEGASCOPE™ is ready.

5. Connect a signal to one of the scope device's input channels and see
your first waveform! To learn more about using OMEGASCOPE™, please
read the OMEGASCOPE™ Primer.

Problems?

Help is at hand! Our technical support staff are always ready to answer your telephone
call during office hours. At other times, please send us an email.

126

7

mailto:das@omega.com
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5 OMEGASCOPE™ and oscilloscope primer
This chapter explains the fundamental concepts that you will need to know before
working with the OMEGASCOPE™ software. If you have used an oscilloscope before,
then most of these ideas will be familiar to you. You can skip the Oscilloscope basics

 section and go straight to the OMEGASCOPE™-specific information . If you are
new to oscilloscopes, please take a few minutes to read at least the Oscilloscope
basics  and OMEGASCOPE™ basics  topics.

5.1 Oscilloscope basics
An oscilloscope is a measuring instrument that displays a graph of voltage against
time. For example, the picture below shows a typical display on an oscilloscope screen
when a varying voltage is connected to one of its input channels. 

Oscilloscope displays are always read from left to right. The voltage-time
characteristic of the signal is drawn as a line called the trace. In this example, the
trace is blue and begins at point A. If you look to the left of this point, you will see the
number "0.0" on the voltage axis,  which tells you that the voltage is 0.0 V (volts).
If you look below point A, you will see another number "0.0", this time on the time
axis, which tells you that the time is 0.0 ms (milliseconds) at this point.

At point B, 0.25 milliseconds later, the voltage has risen to a positive peak of 0.8
volts. At point C, 0.75 milliseconds after the start, the voltage has dropped to a
negative peak of -0.8 volts. After 1 millisecond, the voltage has risen back to 0.0 volts
and a new cycle is about to begin. This type of signal is called a sine wave, and is one
of a limitless range of signal types that you will encounter.

Most oscilloscopes allow you to adjust the vertical and horizontal scales of the display.
The vertical scale is called the voltage range (in this example at least, although
scales in other units, such as milliamperes, are possible). The horizontal scale is called
the timebase and is measured in units of time - in this example, thousandths of a
second.

7 8

7 9

173
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5.2 PC Oscilloscope basics
A PC Oscilloscope is a measuring instrument that consists of a hardware scope
device and an oscilloscope program running on a PC. Oscilloscopes were were
originally stand-alone instruments with no signal processing or measuring abilities,
and with storage only available as an expensive extra. Later oscilloscopes began to
use new digital technology to introduce more functions, but they remained highly
specialised and expensive instruments. PC Oscilloscopes are the latest step in the
evolution of oscilloscopes, combining the measuring power of OMSP-2000/3000/4000
scope devices with the convenience of the PC that's already on your desk.

+ =
PC scope device PC Oscilloscope
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5.3 OMEGASCOPE™ basics
OMEGASCOPE™ can produce a simple display such as the example in the Oscilloscope
basics  topic, but it also has many advanced features. The screen shot below shows
the OMEGASCOPE™ window. Click on any of the underlined labels to learn more. See 
OMEGASCOPE™ window  for an explanation of these important concepts.

Note: Other buttons may appear in the OMEGASCOPE™ main window depending on
the capabilities of the oscilloscope that is connected, and on the settings applied to
the OMEGASCOPE™ program.

7

12
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5.3.1 Capture modes
OMEGASCOPE™ can operate in three capture modes: scope mode, spectrum mode
and persistence mode. The mode is selected by buttons in the Capture Setup
Toolbar .

In scope mode, OMEGASCOPE™ displays a main scope view,  optimises its
settings for use as a PC Oscilloscope, and allows you to directly set the capture
time. You can still display one or more secondary spectrum views.

In spectrum mode, OMEGASCOPE™ displays a main spectrum view,  optimises
its settings for spectrum analysis, and allows you to directly set the frequency
range in a similar way to a dedicated spectrum analyser. You can still display one
or more secondary scope views.

In persistence mode , OMEGASCOPE™ displays a single, modified scope view in
which old waveforms remain on the screen in faded colors while new waveforms are
drawn in brighter colors. See also: How to find a glitch using persistence mode
and the Persistence Options dialog .

When you save waveforms and settings , OMEGASCOPE™ only saves data for the
mode that is currently in use. If you wish to save settings for both capture modes,
then you need to switch to the other mode and save your settings again.

See also: How do capture modes work with views?

112
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5.3.2 How do capture modes work with views?
The capture mode  tells OMEGASCOPE™ whether you are mainly interested in
viewing waveforms (scope mode ) or frequency plots (spectrum mode ). When
you select a capture mode, OMEGASCOPE™ sets up the hardware appropriately and
then shows you a view that matches the capture mode (a scope view  if you
selected scope mode or persistence mode , or a spectrum view  if you selected
spectrum mode). The rest of this section does not apply in persistence mode, which
allows only a single view.

Once OMEGASCOPE™ has shown you the first view, you can, if you wish, add more
scope or spectrum views, regardless of the capture mode you are in. You can add and
remove as many extra views as you wish, as long as one view remains that matches
the capture mode.

Examples showing how you might select the capture mode and open additional views in
OMEGASCOPE™. Top: persistence mode (one view only). Middle: scope mode. Bottom:

spectrum mode.

When using a secondary view type (a spectrum view in scope mode, or a scope view
in spectrum mode), you may see the data compressed horizontally rather than
displayed neatly as in a primary view. You can usually overcome this by using the
zoom tools.

10

10 10

13

17 16
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5.4 OMEGASCOPE™ window
The OMEGASCOPE™ window shows a block of data captured from the scope device

. When you first open OMEGASCOPE™ it contains one scope view , but you can
add more views by clicking Add view in the Views menu . The screen shot below
shows all the main features of the OMEGASCOPE™ window. Click on the underlined
labels for more information.

To arrange the views within the OMEGASCOPE™ window

If the OMEGASCOPE™ window contains more than one view , OMEGASCOPE™
arranges them in a grid. This is arranged automatically, but you can customize it if
you wish. Each rectangular space in the grid is called a viewport . You can move a
view  to a different viewport by dragging its name tab (show me ), but you cannot
move it outside the OMEGASCOPE™ window. You can also put more than one view in
a viewport, by dragging a view and dropping it on top of another.

For further options, right-click on a view to obtain the View menu , or select View
from the Menu bar , then select one of the menu options to arrange the views.

174 13

40

174

174

174 139
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5.5 Scope view
A scope view shows the data captured from the scope as a graph of signal amplitude
against time. (See Oscilloscope basics  for more on these concepts.)
OMEGASCOPE™ opens with a single view, but you can add more views by using the 
views menu . Similar to the screen of a conventional oscilloscope, a scope view
shows you one or more waveforms with a common horizontal time axis, with signal
level shown on one or more vertical axes. Each view can have as many waveforms as
the scope device has channels. Click on one of the labels below to learn more about a
feature.

Scope views are available regardless of which mode - scope mode  or spectrum
mode  - is active.

7

40

10

10
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5.6 XY view
An XY view, in its simplest form, shows a graph of one channel plotted against
another. XY mode is useful for showing phase relationships between periodic signals
(using Lissajous figures) and for plotting I-V (current-voltage) characteristics of
electronic components.

In the example above, two different periodic signals have been fed into the two input
channels. The smooth curvature of the trace tells us that the inputs are roughly or
exactly sine waves. The three loops in the trace show that Channel B has about three
times the frequency of Channel A. We can tell that the ratio is not exactly three
because the trace is slowly rotating, although you cannot see that in this static
picture. Since an XY view has no time axis, it tells us nothing about the absolute
frequencies of the signals. To measure frequency, we need to open a Scope view .

How to create an XY view

There are two ways to create an XY view.

Use the Add View > XY command on the Views menu . This adds a new XY view
to the OMEGASCOPE™ window without altering the original scope  or spectrum

 view or views. It automatically chooses the two most suitable channels to place
on the X and Y axes. Optionally, you can change the X axis channel assignment
using the X-Axis command (see below).

Use the X-Axis command on the Views menu . This converts the current scope
view into an XY view. It maintains the existing Y axes and allows you to choose any
available channel for the X axis. With this method, you can even assign a math
channel  or a reference waveform  to the X axis.

13

40
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5.7 Trigger marker
The trigger marker shows the level and timing of the trigger point.

The height of the marker on the vertical axis shows the level at which the trigger is
set, and its position on the time axis shows the time at which it occurs.

You can move the trigger marker by dragging it with the mouse or, for more accurate
control, by using the buttons on the Triggering toolbar .

Other forms of trigger marker

If the scope view is zoomed and panned so that the trigger point is off the screen, the
off-screen trigger marker (shown above) appears at the side of the graticule to
indicate the trigger level.

In post-trigger delay mode, the trigger marker is temporarily replaced by the post-
trigger arrow  while you adjust the post-trigger delay.

When some advanced trigger types  are in use, the trigger marker changes to a
window marker, which shows the upper and lower trigger thresholds.

For more information, see the section on Trigger timing .

5.8 Post-trigger arrow
The post-trigger arrow is a modified form of the trigger marker  that appears
temporarily on a scope view  while you are setting up a post-trigger delay, or
dragging the trigger marker after setting up a post-trigger delay. (What is a post-
trigger delay? )

The left-hand end of the arrow indicates the trigger point, and is aligned with zero on
the time axis. If zero on the time axis is outside the scope view,  then the left-hand
end of the post-trigger arrow appears like this:

127
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The right-hand end of the arrow (temporarily replacing the trigger marker )
indicates the trigger reference point.

Use the buttons on the Triggering toolbar  to set up a post-trigger delay.

5.9 Spectrum view
A spectrum view is one view of the data from a scope device. A spectrum is a
diagram of signal level on a vertical axis plotted against frequency on the horizontal
axis. OMEGASCOPE™ opens with a scope view, but you can add a spectrum view by
using the views menu . Similar to the screen of a conventional spectrum analyser, a
spectrum view shows you one or more spectra with a common frequency axis. Each
view can have as many spectra as the scope device has channels. Click on one of the
labels below to learn more about a feature.

 

Unlike in the scope view, in the spectrum view the data is not clipped at the limits of
the range displayed on the vertical axis, so you can apply axis scaling or offset to see
more data. Vertical axis labels are not provided for data outside what is considered to
be the 'useful' range, but rulers will still work outside this range.

Spectrum views are available regardless of which mode - Scope Mode  or Spectrum
Mode  - is active.

For more information, see: How to set up the spectrum view  and Spectrum
Options dialog.
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5.10 Persistence mode
Persistence mode superimposes multiple waveforms on the same view, with more
frequent data or newer waveforms drawn in brighter colors than older ones. This is
useful for spotting glitches, when you need to see a rare fault event hidden in a series
of repeated normal events.

Enable persistence mode by clicking the Persistence Mode button  on the
Capture Setup toolbar . With the persistence options  set at their default
values, the screen will look something like this:

The colors indicate the frequency of the data. Red is used for the highest-frequency
data, with yellow for intermediate frequencies and blue for the least frequent data. In
the example above, the waveform spends most of its time in the red region, but noise
causes it to wander occasionally into the blue and yellow regions. These are the
default colors, but you can change them using the Persistence Options dialog .

This example shows persistence mode in its most basic form. See the Persistence
Options dialog  for ways to modify the display to suit your application, and How to
find a glitch using persistence mode  for a worked example.

112 116

116
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5.11 Measurements table
A measurements table displays the results of automatic measurements. Each view

 can have its own table, and you can add, delete or edit measurements from this
table.

Column
heading

Explanation

Name The name of the measurement that you selected in the Add
Measurement  or Edit Measurement  dialog. An "F" after the
name indicates that the statistics for this measurement are filtered .

Span The section of the waveform or spectrum that you want to measure.
This is 'Whole trace' by default.

Value The live value of the measurement, from the latest capture

Min The minimum value of the measurement since measuring began

Max The maximum value of the measurement since measuring began

Average The arithmetic mean of the measurements from the last n captures,
where n is set in the General  page of the Preferences  dialog

Standard
Deviation

The standard deviation  of the measurements from the last n
captures, where n is set in the General  page of the Preferences
dialog

Capture
Count

The number of captures used to create the statistics above. This starts
at 0 when triggering is enabled, and counts up to the number of
captures specified in the General  page of the Preferences  dialog.

To add, edit or delete measurements

See: Measurements toolbar .

To change the width of a measurement column

Drag the vertical separator between column headings to create
the column width you need, as shown opposite.

  

To change the update rate of the statistics

The statistics (Min, Max, Average, Standard Deviation) are based on the number
of captures shown in the Capture Count column. You can change the maximum
capture count using the Capture Size control in the General page  of the
Preferences dialog.
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5.12 Resolution enhancement
Resolution enhancement is a technique for increasing the effective vertical
resolution of the scope at the expense of high-frequency detail. Selecting resolution
enhancement does not change the scope's sampling rate or the number of samples
available.

For this technique to work, the signal must contain a very small amount of Gaussian
noise, but for many practical applications this is generally taken care of by the scope
itself and the noise inherent in normal signals.

The resolution enhancement feature uses a flat moving-average filter. This acts as a
low-pass filter with good step response characteristics and a very slow roll-off from
the pass-band to the stop-band.

Some side-effects will be observed when using resolution enhancement. These are
normal and can be counteracted by reducing the amount of enhancement used,
increasing the number of samples captured or changing the timebase. Trial and error
is usually the best way to find the optimum resolution enhancement for your
application. The side-effects include:

Widened and flattened impulses (spikes)
Vertical edges (such as those of square waves) turned into straight-line slopes
Inversion of the signal (sometimes making it look as if the trigger point is on the
wrong edge)
A flat line (when there are not enough samples in the waveform)

Procedure

Click the Channel Options button  in the Channel Setup toolbar .
Use the Resolution Enhancement control in the Advanced Options menu  to
select the effective number of bits, which can be equal to or greater than the 
vertical resolution  of your scope device.
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Quantifying Resolution Enhancement

The table below shows the size of the moving-average filter for each resolution
enhancement setting. A bigger filter size requires a higher sampling rate to represent
a given signal without significant side-effects (as detailed above).

Resolution
enhancement

e (bits)

Number of
values

n

0.5 2

1.0 4

1.5 8

2.0 16

2.5 32

3.0 64

3.5 128

4.0 256

Example. Your scope device is an OMSP-2205 (resolution = 8 bits). You have selected
an effective resolution of 9.5 bits. The resolution enhancement is therefore:

e = 9.5 - 8.0 = 1.5 bits.

The table shows that this is achieved using a moving average of:

n = 8 samples.

This number gives a guide to what sort of filtering effect the resolution enhancement
will have on the signal. The best way of seeing the actual low-pass filter effect is to
add a spectrum view and look at the shape of the noise floor (try dragging the y-axis
upwards to see the noise more clearly).

5.13 Pointer tool tip
The pointer tool tip is a box that displays the horizontal and vertical axis values at
the mouse pointer location. It appears temporarily when you click the background of
a view . 

Pointer tool tip
in a scope view

174
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5.14 Signal rulers
The signal rulers (sometimes called cursors) help you measure absolute and relative
signal levels on a scope , XY  or spectrum view .

In the scope view  above, the two colored squares to the left of the vertical axis are
the ruler drag-handles for channel A. Drag one of these downwards from its resting
position in the top left corner, and a signal ruler (a horizontal dashed line) will
extend from it.

Whenever one or more signal rulers is in use, the ruler legend  appears. This is a
table showing all of the signal ruler values. If you close the ruler legend using the 
Close button, all the rulers are deleted.

Signal rulers also work in spectrum  and XY  views.

Ruler tool tip

If you move the mouse pointer over one of the rulers, OMEGASCOPE™ displays a tool
tip  with the ruler number and the signal level of the ruler. You can see an example
of this in the picture above.
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5.15 Time rulers
The time rulers (sometimes called cursors) measure time on a scope view  or
frequency on a spectrum view .

In the scope view  above, the two white squares on the time axis are the time ruler
handles. When you drag these to the right from the bottom left corner, vertical
dashed lines called time rulers appear. The rulers work in the same way on a
spectrum view , but the ruler legend shows their horizontal positions in units of
frequency rather than time.

Ruler tool tip

If you hold the mouse pointer over one of the rulers, as we did in the example above,
OMEGASCOPE™ displays a tool tip with the ruler number and the time value of the
ruler.

Ruler legend

The table at the top of the view is the ruler legend. In this example, the table shows
that time ruler 1 is at 148.0 microseconds, ruler 2 is at 349.0 microseconds and the
difference between them is 201.0 microseconds. Clicking the Close button on the
ruler legend also deletes all the rulers.

Frequency legend

The frequency legend in the bottom right-hand corner of a scope view shows 1/ ,
where  is the difference between the two time rulers. The accuracy of this calculation
depends on the accuracy with which you have positioned the rulers. For greater
accuracy with periodic signals, use the frequency measurement  function built in to
OMEGASCOPE™.
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5.16 Ruler legend
The ruler legend is a box that displays the positions of all the rulers  you have
placed on the view . It appears automatically whenever you position a ruler on the
view:

Editing

You can adjust the position of a ruler by editing any value in the first two columns. To

insert a Greek µ (the micro symbol, meaning one millionth or x 10-6), type the letter
'u'.

Tracking rulers

When two rulers have been positioned on one channel, the Lock button  appears
next to that ruler in the ruler legend. Clicking this button causes the two rulers to
track each other: dragging one causes the other one to follow it, maintaining a fixed

separation. The button changes to  when the rulers are locked.

TIP: To set up a pair of tracking rulers with a known distance between them, first
click the Lock button, then edit the two values in the ruler legend so that the rulers
are the desired distance apart.

See also: frequency legend .

5.17 Frequency legend

The frequency legend appears when you have placed two time rulers  on a scope
view . It shows 1/  in hertz (the SI unit of frequency, equal to cycles per second),
where   is the time difference between the two rulers. You can use this to estimate
the frequency of a periodic waveform, but you will get more accurate results by
creating a frequency measurement using the Add Measurements button on the
Measurements toolbar .

For frequencies up to 1.666 kHz, the frequency legend can also show the frequency in
RPM (revolutions per minute). The RPM display can be enabled or disabled in the 
Preferences > Options dialog .
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5.18 Properties sheet
The Properties sheet is a summary of the settings that OMEGASCOPE™ is using. It is
enabled using the Views > View Properties menu command, and appears to the
right of the waveforms in the OMEGASCOPE™ window. 

Window. The window function
applied to the data before computing
the spectrum. This is selected in the 
Spectrum options dialog .

Time gate. The number of samples
that OMEGASCOPE™ uses to compute a
spectrum is equal to twice the number
of bins. This number of samples is
expressed as a time interval called the
time gate. It is measured from the
start of the capture.

5.19 Custom probes
A probe is any connector, transducer or measuring device that you connect to an
input channel of your scope device . OMEGASCOPE™ has a built-in library of
common probe types, such as the x1 and x10 voltage probes used with most
oscilloscopes, but if your probe is not included in this list you can use the Custom
Probes dialog  to define a new one. Custom probes can have any voltage range
within the capabilities of the oscilloscope, display in any units, and have either linear
or nonlinear characteristics.

Custom probe definitions are particularly useful when you wish to display the probe's
output in units other than volts, or to apply linear or nonlinear corrections to the data.
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5.20 Maths channels
A maths channel is a mathematical function of one or more input signals. The
function can be as simple as "Invert A", replacing the Invert button on a conventional
oscilloscope, or a complex function that you define. It can be displayed in a scope ,
XY  or spectrum  view in the same way as an input signal, and like an input signal
it has its own measurement axis, scaling and offset button  and color .
OMEGASCOPE™ has a set of built-in math channels for the most important functions,
including "A+B" (the sum of channels A and B) and "A-B" (the difference between
channels A and B). You can also define your own functions using the equation editor

, or load predefined maths channels from files .

The picture below is a three-step guide to using maths channels:

1. Tools  > Maths Channels command. Click this to open the Maths Channels
dialog , shown at top right in the picture above.

2. Maths Channels dialog . This lists all the available maths channels. In the
example above, only the built-in functions are listed.

3. Maths channel. Once enabled, a maths channel appears in the selected scope
or spectrum  view. You can change its scale and offset  as with any other
channel. In the example above, the new maths channel (bottom) is defined as A-B,
the difference between input channels A (top) and B (middle).

You may occasionally see a flashing warning symbol like this-  - at the bottom of
the maths channel axis. This means that the channel cannot be displayed because
an input source is missing. For example, this occurs if you enable the A+B function
while channel B is set to Off.
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5.21 Reference waveforms
A reference waveform is a stored copy of an input signal. You can create one by
right-clicking on the view, selecting the Reference Waveforms command and
selecting which channel to copy. It can be displayed in a scope or spectrum view in
the same way as an input signal, and like an input signal it has its own measurement
axis, scaling and offset button  and color . 

For more control over Reference Waveforms, use the Reference Waveforms dialog
as shown below.

1. Reference Waveforms button. Click this to open the Reference Waveforms
dialog , shown on the right in the picture above.

2. Reference Waveforms dialog . This lists all the available input channels and
reference waveforms. In the example above, input channels A and B are switched
on, so they appear in the Available section. The Library section is empty to begin
with. 

3. Duplicate button. When you select an input channel or reference waveform and
click this button, the selected item is copied to the Library section.

4. Library section. This shows all your reference waveforms. Each one has a check
box that controls whether or not the waveform appears on the display.

5. Reference waveform. Once enabled, a reference waveform appears in the
selected scope  or spectrum  view. You can change its scale and offset  as
with any other channel. In the example above, the new reference waveform
(bottom) is a copy of channel A.

6. Axis control button. Opens an axis scaling dialog  allowing you to adjust scale,
offset and delay for this waveform.
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5.22 Serial decoding
You can use OMEGASCOPE™ to decode data from a serial bus such as I2C or CAN Bus.
Unlike a conventional bus analyzer, OMEGASCOPE™ lets you see the high-resolution
electrical waveform at the same time as the data. The data is integrated into the
scope view, so there's no need to learn a new screen layout.

How to use Serial Decoding

1. Select the Tools  > Serial Decoding menu command.

2. Complete the Serial Decoding dialog .

3. Choose to display the data In View, In Window , or both.

4. You can decode multiple channels in different formats simultaneously. Use the
Decoding tab below the "In Window" data table (shown in the picture above) to
select which channel of data to display in the table.
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5.23 Mask limit testing
Mask limit testing is a feature that tells you when a waveform or spectrum goes
outside a specified area, called a mask, drawn on the scope view  or spectrum view

. OMEGASCOPE™ can draw the mask automatically by tracing a captured
waveform, or you can draw it manually. Mask limit testing is useful for spotting
intermittent errors during debugging, and for finding faulty units during production
testing.

To begin, go to the main OMEGASCOPE™ menu and select Tools  > Masks  >
Add Masks. This opens the Mask Library dialog . When you have selected, loaded
or created a mask, the scope view will appear as follows:

(A) Mask Shows the allowed area (in white) and the disallowed
area (in blue). Right-clicking the mask area and
selecting the Edit Mask command takes you to the
Edit Mask dialog . You can change the mask colors
with the Tools  > Preferences  > Colors
 dialog; add, remove and save masks using the Masks
menu ; and hide and display masks using the Views
> Masks menu .

(B) Failed waveforms If the waveform enters the disallowed area, it is
counted as a failure. The part of the waveform that
caused the failure is highlighted, and persists on the
display until the capture is restarted.

(C) Measurements table The number of failures since the start of the current
scope run is shown in the Measurements table .
You can clear the failure count by stopping and
restarting the capture using the Start/Stop button .
The measurements table can display other
measurements  at the same time as the mask failure
count.
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5.24 Alarms
Alarms are actions that OMEGASCOPE™ can be programmed to execute when certain
events occur.  Use the Tools > Alarms command to open the  Alarms dialog ,
which configures this function.

The events that can trigger an alarm are:

Capture - when the oscilloscope has captured  a complete waveform or block of
waveforms.
Buffers Full - when the waveform buffer  becomes full.
Mask(s) Fail - when a waveform fails a mask limit test .

The actions that OMEGASCOPE™ can execute are:

Beep
Play Sound
Stop Capture
Restart Capture
Run Executable
Save Current Buffer
Save All Buffers

See Alarms dialog  for more details.
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5.25 Buffer Navigator
The OMEGASCOPE™ waveform buffer can hold up to 10,000 waveforms, subject to the
amount of available memory in the oscilloscope. The Buffer Navigator helps you to
scroll through the buffer quickly to find the waveform you want.

To begin, click the Buffer Navigator  button in the Buffer Navigation toolbar
. This opens the Buffer Navigator window:

Click on any one of the visible waveforms to bring it to the front of the navigator for
closer inspection, or use the controls:

Buffers to show If any of the channels has a mask  applied, then you can
select the channel from this list. The Buffer Navigator will
then show only the waveforms that failed the mask test on that
channel.

 Start: Scroll to waveform number 1.

 Backward: Scroll to the next waveform on the left.

 Zoom in:

Change the scale of the waveforms in the Buffer Navigator
view. There are three zoom levels: 
Large: default view. One waveform fills the height of the
window.
Medium: a medium-sized waveform above a row of small
waveforms.
Small: a grid of small waveforms. Click on the top or bottom
row of images to scroll the grid up or down.

 Zoom out:

 Forward: Scroll to the next waveform on the right.

 End:

Scroll to the last waveform in the buffer. (The number of
waveforms depends on the Tools  > Preferences  > 
General > Maximum Waveforms setting and on the type of
scope connected.)

Click anywhere on the main OMEGASCOPE™ window to close the Buffer Navigator
window.
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6 Menus
Menus are the quickest way to get to OMEGASCOPE™'s main features. The Menu bar
is always present at the top of the OMEGASCOPE™ main window, just below the
window's title bar. You can click any of the menu items, or press the Alt key and then
navigate to the menu using the arrow keys, or press the Alt key followed by the
underlined letter in one of the menu items.

The list of items in the menu bar may vary depending on the windows that you have
open in OMEGASCOPE™.
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6.1 File menu
Location: Menu bar  > File

Purpose: gives access to file input and output operations

  

Connect Device. This command appears only when there is no scope device
connected. It opens the Connect Device dialog , which allows you to select
the scope device you wish to use.

Open. Allows you to select the file you want to open. OMEGASCOPE™ can
open .psdata and .psd files, which contain both waveform data and scope

device settings, and .pssettings and .pss files, which contain only scope

device settings. You can create your own files using the Save and Save
As... commands, described below. If the file was saved using a different
scope device from the one that is presently connected, OMEGASCOPE™ may
need to modify the saved settings to suit the present device.

Hint: Use the Page Up and Page Down keys to cycle through all the
waveform files in the same directory.

Save All Waveforms. Saves all waveforms using the filename shown in the
title bar.

Save All Waveforms As. Opens the Save As dialog , which allows you to
save the settings, waveforms, custom probes and math channels for all 
views  in various formats. Only the waveforms for the mode currently in
use (Scope Mode  or Spectrum Mode ) will be saved.

Save Current Waveform As. Opens the Save As dialog , which allows
you to save the settings, waveforms, custom probes and math channels for
all views in various formats. Only the waveforms for the mode currently in
use (Scope Mode  or Spectrum Mode ) will be saved.

In persistence mode , this command is called Save Persistence As and
saves only the data for this mode.

Startup Settings. Opens the Startup Settings menu.

Print Preview. Opens the Print Preview window, which allows you to see
how your workspace will be printed when you select the Print command.
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Print. Opens a standard Windows Print dialog, which allows you to choose a
printer, set printing options and then print the selected view.

Recent Files. A list of recently opened or saved files. This list is compiled
automatically, but you can clear it using the Files page of the Preferences
dialog.

Exit. Close OMEGASCOPE™ without saving any data.

6.1.1 Save As dialog
Location: Menu bar  > File  > Save All Waveforms As or Save Current

Waveform As

Purpose: allows you to save your waveforms and settings (including custom
probes and active math channels) to a file in various formats

 

Type your chosen file name in the File name box, and then select a file format in the
Save as type box. You can save data in the following formats:

Data files (.psdata) Stores waveforms and settings from the
current scope device. Can be opened on any
computer running OMEGASCOPE™.

Settings files (.pssettings) Stores all settings (but not waveforms) from
the current scope device. Can be opened on
any computer running OMEGASCOPE™.
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CSV (Comma delimited) files (.csv) Stores waveforms as a text file with comma-
separated values. This format is suitable for
importing into spreadsheets such as Microsoft
Excel. The first value on each line is the time
stamp, and it is followed by one value for
each active channel, including currently
displayed math channels. (Details)

Text (Tab delimited) files (.txt) Stores waveforms as a text file with tab-
separated values. The values are the same as
those in the CSV format. (Details)

Bitmap images (.bmp) Stores a picture of the waveforms, graticule
 and rulers  in Windows BMP format. The

image is 800 pixels wide by 600 pixels high,
in 16 million colors, and uncompressed. BMP
files are suitable for importing into Windows
desktop-publishing programs.

GIF images (.gif) Stores the waveforms, graticule  and rulers
 in Compuserve GIF format. The image is

800 pixels wide by 600 pixels high, in 256
colors, and compressed. GIF files are widely
used to illustrate web pages.

Animated GIF image (*.gif) Creates an animated GIF that displays all of
the waveforms in the buffer in sequence.
Each waveform is formatted as in the single
GIF format described above.

PNG images (.png) Stores the graticule , rulers  and
waveforms in Portable Network Graphics
format. The image is 800 pixels wide by 600
pixels high, in 16 million colors, and
compressed.

Matlab 4 files (.mat) Stores the waveform data in Matlab 4 format
.
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6.1.1.1 File formats for exported data

OMEGASCOPE™ can export raw data in either text or binary format: -

Text-based file formats

Easy to read without special tools
Can be imported into standard spreadsheet applications
Files are very large if there are many samples in the data (so files are limited to
about 1 million values per channel)

Text file format details

Binary file format

Files remain relatively small and can even be compressed in some situations (this
means that the amount of saved data is unlimited)
Either a special application is required to read the files or the user must write a
program to read the data from the file

If you need to save more than 64 K values per channel, then you must use a binary

file format such as the Matlab® MAT-file format.

Binary file format details

Data types for storing OMEGASCOPE™ data

Regardless of whether the data types were loaded from a binary file or from a text-
based file, we recommend the following data formats for storing the values loaded
from a OMEGASCOPE™ data file: -

Sampled data (such as voltages) should use 32-bit single-precision floating-point
data types.
Times should use 64-bit double-precision floating-point data types.

6.1.1.1.1 Text formats

Text-format files exported by OMEGASCOPE™  are encoded in UTF-8 format by
default. This is a popular format which is capable of representing a huge range of
characters, whilst still retaining some compatibility with the ASCII character set if only
standard Western European characters and numbers are used in the file.

CSV (comma-separated values)

CSV files store data in the following format: -

Time, Channel A, Channel B
(µs), (V), (V)
-500.004, 5.511, 1.215
-500.002, 4.724, 2.130
-500, 5.552, 2.212
…

There is a comma after each value on a line to represent a column of data and a
carriage return at the end of the line to represent a new row of data. The 1 million
values per channel limit prevents excessively large files being created.
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Note. CSV files are not the best choice of format if you are working in a language that
uses the comma character as the decimal point. Instead, try using the tab-delimited
format which works in almost the same way.

Tab-delimited

Tab-delimited files store data in the following format: -

Time
(µs)

Channel A
(V)

Channel B
(V)

500.004 5.511 1.215
-500.002 4.724 2.130
-500 5.552 2.212
…

The files have a tab character after each value on a line to represent a column of data
and a carriage return at the end of the line to represent a new row of data. These files
work in any language and are a good choice for sharing data internationally. The 1
million values per channel limit prevents excessively large files being created.

6.1.1.1.2 Binary formats

OMEGASCOPE™ can export data  in version 4 of the .mat binary file format.
This is an open format and the full specification is freely available from the 
www.mathworks.com website. OMEGASCOPE™ saves data into the MAT-File format in
a specific way, which is detailed below.

Importing into Matlab

Load the file into your workspace using this syntax: -

load myfile

Each channel’s data is stored in an array variable named by the channel. So, the
sampled data for channels A to D would be in four arrays named A, B, C and D.

There is only one set of time data for all channels and this is loaded in one of two
possible formats:

1. A start time, an interval and a length. The variables are named Tstart, Tinterval
and Length.

2. An array of times (sometimes used for ETS data). The time array is named T.

If the times are loaded in as Tstart, Tinterval and Length then you can use the
following command to create the equivalent array of times: -

T = [Tstart : Tinterval : Tstart + (Length – 1) * Tinterval];

Exploring the file format

The full file specification, available from www.mathworks.com, is comprehensive so
this guide does not describe the entire format. Instead, this guide describes enough of
the format to allow you to get data from the file and use it in your own program.

The variables described above (under Importing into Matlab ) are stored in a series
of data blocks, each preceded by a header. Each variable has its own header and data
block and the corresponding variable names are stored with them (such as A, B,
Tstart). The following sections describe how to read each variable from the file.
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The order of the data blocks is not specified, so programs should look at the variable
names to decide which variable is currently being loaded.

The header
The file consists of a number of data blocks preceded by 20-byte headers. Each header
contains five 32-bit integers (as described in the table below).

Bytes Value

0 – 3 Data format (0, 10 or 20)

4 – 7 Number of values

8 – 11 1

12 – 15 0

16 – 19 Name length

Data format
The ‘Data format’ in the first 4-bytes describes the type of numerical data in the array.

Value Description

0 Double (64-bit floating point)

10 Single (32-bit floating point)

20 Integer (32-bit)

Number of values
The ‘Number of values’ is a 32-bit integer describing the number of numerical values
in the array. This value may be 1 for variables that only describe one value; but for
arrays of samples or times, expect this to be a large number.

Name length
The ‘Name length’ is the length of the name of the variable as a null-terminated 1-
byte per character ASCII string. The last null terminating character (‘\0’) is included in
the ‘Name length’ so if the variable name is “TStart” (same as ‘TStart\0’) then the
name length will be 7.

The data block
The data block begins with the name of the variable (such as A, Tinterval) and you
should read in the number of bytes described by the ‘Name length’ part of the header
(not forgetting that the last byte in the string is ‘\0’ if your programming language
needs to take account of this).

The remaining part of the data block is the actual data itself, so read in the number of
values described in the ‘Number of values’ part of the header. Remember to take
account of the size of each value as described in the ‘Data format’ part of the header.

Channel data such as voltages, in variables such as A and B, are stored as 32-bit
single-precision floating-point data types. Times such as Tstart, Tinterval and T are
stored as 64-bit double-precision floating-point data types. Length is stored as a 32-
bit integer.
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6.1.2 Startup Settings menu
Location: Menu bar  > File  > Startup Settings

Purpose: allows you to load, save and restore the OMEGASCOPE™ startup
settings

 

Save Startup Settings. Saves your current settings ready for when you
next select Load Startup Settings. These settings are remembered from
one session of OMEGASCOPE™ to the next.

Load Startup Settings. Returns to the settings you created with the Save
Startup Settings command.

Reset Startup Settings. Deletes the startup settings you created with the
Save Startup Settings command, and restores the installation default
settings.

6.2 Edit menu
Location: Menu bar  > Edit

Purpose: gives access to the clipboard-related and note editing functions

 

Copy as Image. Copies the active view to the clipboard as a bitmap. You
can then paste the image into any application that accepts bitmap images.

Copy as Text. Copies the data in the active view to the clipboard as text.
You can paste the data into a spreadsheet or other application. The text
format is the same as that used by the Save As dialog  when you select
the .txt format.

Copy Entire Window as Image. This copies a picture of the
OMEGASCOPE™ window to the clipboard, and is equivalent to pressing Alt-
PrtScn on a full-size keyboard. You can then paste the picture into any
application that can display pictures, such as a word processor or desktop
publishing program.

Notes. Opens a Notes area  at the bottom of the OMEGASCOPE™ window.
You can type or paste your own notes in this area.
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6.2.1 Notes area
Location: Menu bar  > Edit  > Notes

Purpose: a text box for typing your own notes

 

A Notes area can be displayed at the bottom of the OMEGASCOPE™ window. You can
enter any text you wish in this area. You can also copy text from another program and
paste it here.
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6.3 Views menu
Location: Menu bar  > Views, or right-click

on a view

Purpose: controls the layout of the current view
, which is a rectangular area of the

OMEGASCOPE™ window that display
scope, spectrum or other kinds of data

The contents of the Views menu may vary
depending on where you click and how many views
are open. If the current view contains a 
Measurements table , a combined Measurements
menu  and Views menu will appear.

Add View: Add a view of the selected type (scope , XY  or spectrum
). In automatic grid layout mode (the default),

OMEGASCOPE™ rearranges the grid to make room for the
new view, up to a limit of four views. Any further views will
be added as tabs in existing viewports . If you have
selected a fixed grid layout, OMEGASCOPE™ will not change
it.

Rename View: Change the standard 'Scope' or 'Spectrum' label to a title of
your choice.

Close View: Remove a view from the OMEGASCOPE™ window. In
automatic grid layout mode (the default), OMEGASCOPE™
rearranges the grid to make the best use of the remaining
space. In fixed grid layout mode (if you have selected a grid
fixed layout), OMEGASCOPE™ will not change the grid.

Channels: Select which channels are visible in the current view. Each
view, when created, shows all the input channels, but you
can switch them on and off using this command. Only the
input channels that are enabled (not set to "Off" in the 
Channel Setup Toolbar ) are available for viewing. The
Channels menu also list math channels . You can select
up to 8 channels in any view.
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X-Axis: Select any suitable channel to drive the X axis. By default,
the X axis represents time. If you select an input channel
instead, the scope view will become an XY view  that plots
one input against another. A quicker way to create an XY
view is to use the Add View command (see above).

Grid Layout: The grid layout defaults to "Automatic" mode, in which
OMEGASCOPE™ automatically arranges views in a grid. You
can also select one of the standard grid layouts or create a
custom layout, which OMEGASCOPE™ will preserve as you
add or remove views.

Arrange Grid Layout: Adjust the grid layout to fit the number of views. Moves any
tabbed views to empty viewports. Overrides any previous
choice of grid layout.

Reset View Sizes: If you have resized any of the views by dragging the vertical
or horizontal separator bars between viewports, this option
resets all the viewports to their original sizes.

Move View To: Move a view to a specified viewport. You can achieve the
same effect by dragging the view by its name tab and
dropping it in a new viewport. See How to move a view .

Auto-arrange Axes: Scale and offsets all traces to fill the view and avoid
overlaps. 

Reset View Layout: Reset the scale factor and offset of the selected view to their
default values.

Arrange views: If multiple views are stacked in the same viewport, move
them into their own viewports.

View Properties: Show the Properties sheet , which lists scope settings that
are normally hidden.

Reference Waveforms:Create a new Reference Waveform  by copying one of the
available channels, and add it to the view. To edit or remove
a waveform, use the Tools > Reference Waveforms  menu
command.

Masks: Select which masks (see Mask Limit Testing ) are visible.
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6.3.1 Custom grid layout dialog
Location: right-click on view > Views menu  > Grid Layout > Custom

layout...  
Menu bar  > View

Purpose: if the Grid Layout section of the Views menu  does not contain the
layout you want, this dialog gives further options

You can lay out the view  grid with any number of rows and columns up to 4 by 4.
You can then drag the views to different locations in the grid.
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6.4 Measurements menu
Location: Menu bar  > Measurements 

Purpose: controls the Measurements table  

Add measurement. Adds a row to the measurements table , and
opens the Edit Measurement Dialog . You can also find this button on
the Measurements toolbar .

Edit measurement. This takes you to the Edit Measurement Dialog .
You can find this button on the Measurements toolbar , or you can edit
a measurement by double-clicking on a row of the measurements Table

.

Delete measurement. Removes the selected row from the
measurements table . You can also find this button on the
Measurements toolbar .

Grid font size. Sets the font size for the entries in the measurements
table .

Column Auto-width. If this button is pressed, the columns of the
measurements table  will continually adjust to fit the contents
whenever the table changes. Click again to release the button.
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6.4.1 Add / Edit Measurement dialog
Location: Measurements toolbar  >  Add Measurement or  Edit

Measurement button

Views menu  >  Add Measurement or  Edit Measurement
button
Double-click a measurement in the measurements table  

Purpose:  allows you to add a measurement of a waveform to the selected view,
 or edit an existing measurement

 

OMEGASCOPE™ automatically refreshes the measurement every time it updates the
waveform. If this is the first measurement for the view, OMEGASCOPE™ will create a
new measurements table  to display the measurement; otherwise, it will add the
new measurement to the bottom of the existing table.

Channel Which of the scope device's  channels to measure.

Type OMEGASCOPE™ can calculate a wide range of measurements for
waveforms. See Measurement Types  for details.

Section Measure the whole trace, just the section between rulers , or,
where appropriate, a single cycle marked by one of the rulers.

Advanced Gives access to advanced measurement settings .
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6.4.2 Advanced measurement settings
Location: Add Measurement  or Edit Measurement dialog > Advanced 

Purpose: adjust parameters of certain measurements such as filtering and 
spectrum analysis  

Threshold Some measurements, such as Rise Time and Fall Time, can
be made using different thresholds. Select the appropriate
ones here. When comparing rise and fall times with
manufacturers' specifications, it is important to use the same
thresholds for all measurements.

Spectrum Span When measuring peak-related parameters such as 
'Frequency at Peak'  in a spectrum view ,
OMEGASCOPE™ can search for a peak near to the specified 
ruler  location. This option tells OMEGASCOPE™ how many
frequency bins to search. The default is 5, which tell
OMEGASCOPE™ to search from 2 bins below to 2 bins above
the ruler frequency, giving a total range of 5 bins including
the ruler frequency.
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Filter control OMEGASCOPE™ can low-pass filter the statistics to produce
more stable and more accurate numbers. Filtering is not
available on all measurement types.
Enable Filter - check to enable low-pass filtering, if
available. An "F" will appear after the measurement name in
the measurements table .
Automatic - check to set the low-pass filter characteristics
automatically

Cutoff Frequency The filter cut-off frequency normalised to the measurement
rate. Range: 0 to 0.5.

Filter Size The number of samples used to construct the filter

Harmonic Control These options apply to distortion measurements in spectrum
views . You can specify which harmonics OMEGASCOPE™
uses for these measurements.

Highest Harmonic The highest harmonic to include when calculating distortion
power

Search Range The number of frequency bins to search, centred on the
expected frequency, when looking for a harmonic peak

Harmonic Noise Floor The level in dB above which signal peaks will be counted as
harmonics

18

16



OMEGASCOPE™ User's Guide 47

 M5064

6.5 Tools menu
Location: Menu bar  > Tools 

Purpose: gives access to assorted tools for signal analysis 

Custom Probes : Define new probes and copy, delete, move and edit
existing ones.

Maths Channels : Add or edit a channel that is a mathematical function
of one or more other channels.

Reference Waveforms : Create, load or save a channel as a copy of an
existing channel.

Serial Decoding : Decode and display the contents of serial data stream
such as CAN bus.

Alarms : Specify actions to be taken on certain events.

Masks : Perform mask limit testing  on a waveform. This detect when
the waveform departs from a specified shape.

Macro Recorder : Save a frequently-used sequence of operations.

Preferences : Set various options that control OMEGASCOPE™'s
behaviour.
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6.5.1 Custom Probes dialog
Location: Tools  > Custom Probes, or click the Channel Options button (

) 

Purpose: allows you to select predefined probes and set up custom probes  

The selection of probes shown may vary depending on the version of the
OMEGASCOPE™ software that you are using.

Understanding the probe list

All the probes that OMEGASCOPE™ knows about are listed under three main
headings: Built-in, Library and Loaded. The probe list is preserved between
sessions, so that OMEGASCOPE™ will never forget your custom probes unless you
delete them.

Built-in probes. The built-in probes are supplied by Omega Engineering, Inc. and
do not change unless you download an authorized update from us. As a safeguard,
OMEGASCOPE™ does not allow you to edit or delete these probes. If you want to
modify one of them, you can copy it to your library by clicking Duplicate, and then
edit the copy in your library.
Library probes. These are the probes that you have created using any of the
methods described in this topic. You can edit, delete or duplicate any of these
probes by clicking the appropriate button in this dialog.
Loaded probes. Probes in OMEGASCOPE™ data files (.psdata) or settings files

(.pssettings) that you have opened appear here until you copy them to your

library. You cannot edit or delete these probes directly, but you can click Duplicate
to copy them to your library where you can edit them.
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Adding a new probe to your library

There are three ways to create a new probe:

1. Use the Duplicate button as described above.

2. Click New Probe... to define a new probe.

3. Click Import to load a probe definition from a *.psprobe file and add it to your

library. These files are normally supplied, but you can also create your own by
defining a new probe and then clicking Export.

Methods 2 and 3 open the Custom Probe Wizard  to guide you through the probe
definition process.
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6.5.1.1 Custom Probe wizard

Location: Custom Probes dialog  > New Probe 

Purpose: allows you to define custom probes  and set up custom ranges 

The first dialog in the series is either the Create a new Custom Probe dialog  or the
Edit an existing Custom Probe dialog .

6.5.1.1.1 Create New Custom Probe dialog

Location: Custom Probes dialog  > New Probe 

Purpose: introduces you to the process for creating a new custom probe 

How to use the dialog

Click Next to continue to the Probe Output Units dialog .
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6.5.1.1.2 Edit Existing Custom Probe dialog

Location: Custom Probes dialog  > Edit 

Purpose: introduces you to the process for editing an existing custom probe  

How to use the dialog

Click Next to continue to the Probe Output Units dialog , where you can edit the
custom probe.

Click Jump forward... if you have already set up the custom probe's basic
characteristics and want to add or change a custom range manually.
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6.5.1.1.3 Probe Output Units dialog

Location: Create new Custom Probe dialog  > Next 

Purpose: allows you to choose the units that OMEGASCOPE™ will use to display
the output of your custom probe  

How to use the dialog

To choose a standard SI unit, click Use a standard unit from the list and select
one from the list.
To enter a custom unit, click Use the custom unit defined below and type the
unit name and symbol.

Click Next to continue to the Scaling Method dialog .
Click Back to return to the Create New Custom Probe dialog  if this is a new
probe, or the Edit Existing Custom Probe dialog  if this is an existing probe.
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6.5.1.1.4 Scaling Method dialog

Location: Probe Output Units dialog  > Next 

Purpose: allows you to define the characteristic that OMEGASCOPE™ will use to
convert the custom probe 's voltage output to a measurement on the
display

How to use the dialog

If you do not require any scaling or offset, click the Don't apply any scaling
button.

If the probe requires linear scaling, click the Use a linear equation button and
enter the gradient (or scale factor) m and the offset c in the equation y = mx + c,
where y is the displayed value and x is the probe's voltage output.

If you wish to apply a nonlinear function to the probe's output, choose Use a look-
up table..., then click the Create a Lookup Table... button to create a new
lookup table. This will take you to the Lookup-table Scaling dialog .

Click Next to continue to the Range Management dialog .
Click Back to return to the Probe Output Units dialog .
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6.5.1.1.4.1 Lookup-table Scaling dialog

Location: Scaling Method dialog  > Create a Look-up Table or Edit the
Lookup Table...  

Purpose: creates a look-up table to calibrate a custom probe

Editing the Look-up Table

First, select suitable values in the Input units and Scaled units drop-down boxes.
For example, if your probe is a current clamp that outputs one millivolt per ampere
over the range -600 to +600 amperes, select Input units of millivolts and Output
units of amperes.

Next, enter some data in the scaling table. Click the first empty cell at the top of the
table and type "-600", then hit the Tab key and type "-600". When you are ready to
enter the next pair of values, press the Tab key again to start a new row. You can also
right-click on the table to obtain a more detailed menu of options, as shown in the
picture. In the example above, we have entered a slightly nonlinear response; if the
response had been linear then it would have been easier to use the linear option in
the Scaling Method Dialog .

Import/Export

Using the Import and Export buttons, you can fill the look-up table from data in a
comma-separated or tab-delimited text file, and save the look-up table to new file.

Finishing

Clicking OK or Cancel will return you to the Scaling Method dialog .
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6.5.1.1.5 Range Management dialog

Location: Scaling Method dialog  > Next

Purpose: allows you to override OMEGASCOPE™'s automatic range-creation
feature for custom probes. In most cases, the automatic procedure will
be sufficient. 

How to use the dialog

If you select Let the software manage my ranges for me automatically, then
clicking Next will take you to the Custom Probe Identification dialog .
OMEGASCOPE™'s automatic ranges should be ideal for most applications.

If you select I will manage the Custom Probe Ranges manually, clicking Next
will take you to the Manual Ranges Setup dialog .

Click Back to return to the Scaling Method dialog .

What is Auto-ranging?

When the Auto-ranging function is selected, OMEGASCOPE™ continually monitors
the input signal and adjusts the range when necessary to allow it to display the signal
with maximum resolution. This function is available on all standard ranges, and can be
used with custom ranges only if you select Let the software manage my ranges
for me automatically in this dialog.
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6.5.1.1.6 Manual Ranges Setup dialog

Location: Range Management dialog  > Advanced > Next 

Purpose: creates ranges manually for your custom probe  

How to use the dialog

If you wish, you can click Auto Generate Ranges and the program will create a
number of ranges for the selected device. This will create the same list of ranges that
you would have obtained by selecting Let the software manage my ranges for me
automatically in the previous dialog. When you select a range, a diagram below the
list will show its relationship to the scope device's input range — this is explained
further under Edit range dialog . You can then edit the ranges by clicking Edit, or
you can also add a new range by clicking New Range. Both of these buttons take you
to the Edit Range dialog .

Click Next to continue to the Filter Method dialog .

Click Back to return to the Range Management dialog .

How to use a new custom range

After you have created
a custom range, it will
appear in the drop-
down list of ranges in
the channels toolbar,
like this:
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6.5.1.1.6.1 Edit Range dialog

Location: Manual Ranges Setup dialog  > Edit or New Range

Purpose: editing a manual range for a custom probe

Automatic mode

If you leave the "Automatic" radio button pressed, the program will automatically
determine the best hardware input range for the device as you change the Scaled
range limits. This is the best mode to use for almost all ranges. You should set the
Scaled range limits to the maximum and minimum values you wish to see on the
vertical axis of the scope display.

Fixed range mode

If you press the "Hardware input range" radio button and select a hardware input
range from the drop-down box, OMEGASCOPE™ will then use that hardware input
range whatever scaled range limits you choose. Set the upper and lower scaled range
limits to the limits you wish to appear at the top and bottom of the vertical axis in
OMEGASCOPE™'s scope view.  

What is an input range?

An input range is the signal range, usually in volts, on the input channel of the scope
device . Your scaled range should match this as closely as possible to make the
most of the scope's resolution.

What is a scaled range?

The scaled range is the range that will appear on the vertical axis of the scope display
when the probe is selected.

The scaling that you chose on the Scaling Method  page defines the relationship
between the input range and the scaled range. This dialog enables you to set up
ranges to display the scaled data on the scope view.
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The range utilisation bar

This diagram at the bottom of the dialog shows how well the input range of the device
is matched to the scaled range.

• Green - The section of the input range that is used by the scaled range. This
should be as large as possible, to maximise the use of the scope device's
resolution.

• Blue - Areas of the input range that are not being used. These indicate wasted
resolution.

• Grey - Parts of the scaled range that are not covered by the input range. These
will result in wasted space on the graph. The range utilisation bar may not
represent these areas accurately when non-linear scaling is being used, so you
should always test the scaled range limits on the scope view.

Advanced tab

Finishing
Clicking OK or Cancel will return you to the Manual Ranges Setup dialog .56
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6.5.1.1.6.2 Edit Range dialog (Advanced tab)

Location: Manual Ranges Setup dialog  > Edit or New Range > Advanced
tab 

Purpose: configuring advanced options for custom probes  

These options are for factory use and we recommend that you do not change them.

Finishing

Clicking OK or Cancel will return you to the Manual Ranges Setup dialog .
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6.5.1.1.7 Filter Method dialog

Location: Manual Ranges Setup dialog  > Next 

Purpose: sets up lowpass filtering for this custom probe 

This dialog has the same effect as manually enabling the Lowpass Filtering  option
in the Channel Options dialog . Filtering will only occur if the attached scope device
supports filtering.

Back: Go to the Manual Range Setup dialog

Next: Go to the Custom Probe Identification dialog
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6.5.1.1.8 Custom Probe Identification dialog

Location: Range Management dialog  > Next 

Purpose: entering text to identify the custom probe  

How to use the dialog

Click Back to return to the Filter Method dialog .

The probe name will appear in the probe list.
The description is not used in the present version of the software.

Fill in the text fields and click Next to continue to the Custom Probe Finished dialog.
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6.5.1.1.9 Custom Probe Finished dialog

Location: Custom Probe Identification dialog  > Next 

Purpose: signals the end of the custom probe  setup procedure 

How to use the dialog

Click Back to return to the Custom Probe Identification dialog .

Click Finish to accept your custom probe settings and return to the Custom Probes
dialog .
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6.5.2 Maths Channels dialog
Location: Menu bar  > Tools  > Maths Channels  

Purpose: creating , editing  and controlling maths channels , which are
virtual channels generated by mathematical functions of input channels

Maths Channel list The main area of the Maths Channels dialog is the Maths
Channel list, which shows all the built-in, library and loaded
maths channels . To choose whether or not a channel appears
in the main OMEGASCOPE™ window , click the appropriate
check box and then OK. You can have up to 8 channels in any
view, including input channels and maths channels. If you try to
enable a 9th channel, OMEGASCOPE™ will open a new view.

Built In: these maths channels are defined by OMEGASCOPE™
and cannot be changed

Library: these are the maths channels that you define using
the Create or Duplicate button, Edit, or load with the Import
button

Loaded: these are the maths channels present in any
OMEGASCOPE™ settings or data files that you have loaded

Create Opens the Maths Channel Wizard , which guides you
through the process of creating or editing a maths channel. The
new channel will appear under "Library" in the Maths Channel
list.
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Edit Opens the Maths Channel Wizard  to allow you to edit the
selected maths channel. You must first select a channel in the 
Library section of the Maths Channel list. If the channel you
want to edit is in the Built In or Loaded section, first copy it to
the Library section by clicking Duplicate, then select it and
click Edit.

Delete Permanently deletes the selected maths channel. Only maths
channels in the Library section can be deleted.

Duplicate Creates a copy of the selected maths channel. The copy is placed
in the Library section, from where you can edit it by clicking
Edit.

Import Opens a .psmaths math channel file and places the maths

channels it contains in the Library section.

Export Saves all maths channels from the Library section to a new
.psmaths file.
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6.5.2.1 Maths Channel Wizard

Location: Channel Setup toolbar  > Maths Channels button 

Purpose: creating, editing and controlling maths channels, which are virtual
channels generated by mathematical functions of input channels

1. Introduction

2. Equation

3. Channel name

4. Units and range

5. Finished
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6.5.2.1.1 Maths Channel Wizard Introduction dialog

Location: Maths Channels dialog  > Create (if you have not ticked the "Don't
show me this introduction page again" check box) 

Purpose: introduces the Maths Channel Wizard  
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6.5.2.1.2 Maths Channel Wizard Equation dialog

Location: Maths Channel Wizard   

Purpose: allows you to enter or edit the equation for a maths channel . You can
type directly into the equation box, or click the calculator buttons and

let the program insert the symbols for you. A red error indicator  will
appear to the right of the equation box if the equation contains a syntax
error. 

Basic view

Maths Channel Wizard Equation dialog, basic view

Basic buttons

Button Equation
text

Description

CE Clear equation. Clears the entire contents of the equation box.
C Clear. Clears the single character to the left of the cursor.
+ + Addition
- - Subtraction or negation
* * Multiplication
/ / Division
A...D A...D Channel A, B, C or D. If your scope has fewer than 4 channels

then the available channels are named sequentially starting from
A.

v Reference channels. Shows a drop-down list of available reference
channels to insert into the equation.

T T Time, in seconds
(...) (...) Parentheses. Expressions within parentheses will be evaluated

before the expressions to either side.
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Advanced view

Clicking the Advanced button reveals more function buttons, including trigonometric
functions and logarithms.

Maths Channel Wizard Equation dialog, advanced view

Advanced buttons

Button Equation
text

Description

sqrt sqrt() Square root
x^y ^ Raise x to the power of y
ln ln() Natural logarithm
abs abs() Absolute value
norm norm() Normalised value. OMEGASCOPE™ calculates the maximum and

minimum values of the argument over the period of the timebase,
and then scales and offsets the argument so that it exactly fits the
range [0, +1] units.

e^x exp() Exponentiation. Raise e, the base of the natural logarithm, to the
power of x.

log log() Base-10 logarithm
Pi Pi , the ratio of a circle's circumference to its diameter

inv Inverse. Modifies the sin, cos and tan buttons to asin, acos and
atan respectively.

sin sin() Sine of the argument in radians
cos cos() Cosine of the argument in radians
tan tan() Tangent of the argument in radians
0...9 0..9 The decimal digits
. . Decimal point
E E Exponential notation. The number preceding the E is multiplied by

10 raised to the power of the number following the E.
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Advanced equation features

There are a few equation features that can be accessed only by editing the equation
using the keyboard.

Hyperbolic functions. You can enter the sinh(), cosh() and tanh() operators to
obtain hyperbolic functions.

Reference waveforms. You can use a reference waveform as an input to an equation
by typing its name in curly braces. For example, A - {A (2)} subtracts the reference
waveform A (2) from channel A. The name of the reference waveform must be typed
exactly as it appears in the Reference Waveforms dialog , including any spaces.

Signum function. The sign() operator returns the sign of its input. The result is +1
when the input is positive, -1 when the input is negative, and 0 when the input is 0.
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6.5.2.1.3 Maths Channel Wizard Name dialog

Location: Maths Channel Wizard   

Purpose: allows you to enter or edit the name and color of a maths channel  

OMEGASCOPE™ initially sets the name to the text of the equation, but you can edit it
to anything you like. The name will appear in the channel list in the Maths Channels
dialog . You can set the color of the trace to one of the standard colors in the drop-
down-list, or click Custom to choose any possible color allowed by Windows.
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6.5.2.1.4 Maths Channel Wizard Units and Range dialog

Location: Maths Channel Wizard   

Purpose: allows you to specify the measurement units and the range of values to
display for a maths channel  

Units, Long Name: This is for your reference only.

Units, Short Name: This will be displayed on the measurement axis in scope  and
spectrum  views, in the ruler legend  and in the measurements table .

Range: If you leave the check box empty, OMEGASCOPE™ will choose the most
appropriate range for the measurement axis. If you prefer to set your own values for
the minimum and maximum extremes of the measurement axis, tick the check box
and enter them in the Min and Max boxes.
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6.5.2.1.5 Maths Channel Wizard Finished dialog

Location: Maths Channel Wizard   

Purpose: shows you the settings for the maths channel  that you have just
created or edited 

Back. Click this button to return to previous dialogs in the Maths Channel Wizard
 if you wish to change any of the settings.

Finish. Click this button to accept the settings shown and return to the Maths
Channels dialog . If you want the new or edited channel to appear on the scope or
spectrum display, remember to tick the appropriate check box in the channel list. You
can change them later by clicking the Maths Channels button in the Channel Setup
toolbar .
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6.5.3 Reference Waveforms dialog
Location: Tools  > Reference Waveforms  

Purpose: enables you to create, edit  and control reference waveforms ,
which are stored copies of input channels 

Reference
Waveforms list

The main area of the Reference Waveforms dialog is the
Reference Waveforms list, which shows all the available input
channels and the library and loaded reference waveforms . To
choose whether or not a waveform appears in the main 
OMEGASCOPE™ window , click the appropriate check box and
then OK. You can have up to 8 channels in any view, including input
channels, math channels and reference waveforms. If you try to
enable a 9th channel, OMEGASCOPE™ will open a new view.

Available: these input channels are suitable as sources for reference
waveforms

Library: these are the reference waveforms that you have defined
using the Duplicate button or loaded with the Import button

Loaded: these are the reference waveforms present in any
OMEGASCOPE™ settings or data files that you have loaded

Edit Opens the Edit Reference Waveform dialog  to allow you to edit
the selected reference waveform. You must first select a waveform in
the Library section of the Reference Waveforms list. If the
waveform you want to edit is in the Loaded section, first copy it to
the Library section by clicking Duplicate, then select it and click
Edit.
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Delete Permanently deletes the selected reference waveform. Only reference
waveforms in the Library section can be deleted.

Duplicate Creates a copy of the selected input channel or reference waveform.
The copy is placed in the Library section, from where you can edit it
by clicking Edit. A quicker way to do the same thing is to right-click
on the view, select Reference Waveforms and then click the
channel that you wish to copy.

Import Opens a .psreference reference waveform file and places the

waveforms it contains in the Library section.

Export Saves all reference waveforms from the Library section to a new
.psreference or Matlab 4 .mat file.

6.5.3.1 Edit Reference Waveform dialog

Location: Reference Waveforms dialog  > Edit

Purpose: allows you to edit the name and color of a reference waveform

Name. OMEGASCOPE™ initially names the waveform after the input channel used
as its source, but you can edit it to anything you like. Here we have named
it "sine". The name will appear in the waveform list in the Reference
Waveforms dialog . 

Color: You can set the color of the trace to one of the standard colors in the drop-
down-list, or click Custom to choose any color allowed by Windows.
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6.5.4 Serial Decoding dialog
Location: Tools  > Serial Decoding

Purpose: lets you choose which channels to use for serial decoding  and set
other options

The following formats are supported:

I2C
CAN Bus
RS232 (UART)
SPI

Protocols table

This is where you select which channels to decode, and what serial protocol to use for
each channel. All the available channels are listed in the Channels column. 

If the channel you want to use is not listed, enable it first by using the Channels
toolbar . 
For each channel that you want to decode, click in the Protocols column. A drop-
down list will appear, containing all the protocols that OMEGASCOPE™ understands.
The list may vary depending on which version of OMEGASCOPE™ you are using. For

multi-channel protocols like I2C and SPI, select the data channel. Any other
channels will be specified later.
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Select the protocol you wish to use. A Settings panel for the selected channel will
then appear below the table in the dialog.

Settings panel

The settings panel shows all the adjustable settings for the selected channel. The
options available depend on the protocol selected.

Information panel

You do not need to take action on the messages in this panel. If the number of
samples is too small then OMEGASCOPE™ will automatically adjust the capture
settings to improve the signal quality. If the number of samples is larger than
necessary, this is harmless and no adjustment will be made.

Common settings

These apply to all serial data formats.

 Refresh. When you have entered the necessary information, OMEGASCOPE™
analyzes the incoming signal and chooses the best settings for serial decoding. If
OMEGASCOPE™ is unable to decode the data, try improving the signal quality and
then click the Refresh button to analyze the signal again. For best results, click
the Auto Setup button in the Capture Setup toolbar  in the main
OMEGASCOPE™ window  before entering serial decoding mode. This will ensure
that the signal is captured with enough detail for accurate decoding.

Display. Choose where you want to display the data: In View, In Window , or
both.

In View shows the data in logic-analyzer style, on the same time axis as the
analog waveform.

Hover the mouse pointer over any decoded packet to display its contents.

Click-and-drag the decoded data up or down the scope view.

If the In Window  display is visible, double-click on any packet to
highlight it in the table.

In Window displays the decoded data in a table in the serial data window ,
with advanced search and filtering functions. 

CAN Bus  settings

OMEGASCOPE™ can decode either the CAN H or the CAN L signal. Select which one
you are using in the Protocols table.

Threshold. A voltage halfway between the high and low logic levels. If you are not
sure, set this to halfway between the maximum and minimum voltages that you
see on the waveform.

Baud Rate. The speed of data transmission in symbols per second. Set this to
match the speed of the data bus.

I2C  Settings

Clock Channel. Which channel is connected to the SCL signal.
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Clock Threshold. The threshold voltage to use for the SCL signal. 

Data Threshold. The threshold voltage to use for the SDA signal. 

Settings. Opens the I2C Settings dialog .

RS232/UART  Settings

Threshold. A voltage halfway between the high and low logic levels. If you are not
sure, set this to halfway between the maximum and minimum voltages that you
see on the waveform.

Baud Rate. The speed of data transmission in symbols per second. Set this to
match the speed of the data bus.

Bit Definitions. Opens the Bit Definitions dialog  for setting up RS232 format
parameters.

SPI  Settings

Clock Channel. Which channel is connected to the clock signal (SCLK or CLK).

Clock Threshold. The threshold voltage to use for the clock signal.

Data Threshold. The threshold voltage to use for the data signal (SDI, DI, SI,
SDO, DO or SO).

CS Channel. Which channel to use for the chip select (CS, SS or STE) signal, if
present.

CS Threshold. The threshold voltage to use for the chip select signal. 

Settings. Opens the Settings dialog .
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6.5.4.1 Serial Data window

Location: Channels toolbar  > Serial Decoding button > select In Window
in the Serial Decoding dialog

Purpose: shows decoded serial data  in alphanumeric format and allows
advanced filtering and searching

For more information on the format of the table for each serial protocol, see Serial
protocols .

If you also selected In View in the Serial Decoding dialog, the data will also appear
in graphical form on the scope view. You can click on one of the data packets in the
scope view to go to the corresponding row in the table, or you can double-click a row
in the table to zoom to the corresponding frame in the scope view.

Control bar

The controls in the control bar are as follows:

Export Save the decoded data to a Microsoft Excel spreadsheet.

Accumulate By default, OMEGASCOPE™ clears the table each time the scope
captures a new buffer full of data. Click this button to enter 
Accumulate mode, which continues adding serial frames to the end
of the table until you click the button again.

View Controls which details of the data appear in the table. The sub-
menus are as follows:

View > Frames/Packets: which types of frames or packets are
displayed

View > Fields: which columns appear in the data table
View > Display Format: hexadecimal, binary, ASCII or decimal

format
View > Font Size: the character size used in the table
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Link This drop-down list selects or opens a
spreadsheet file that maps numbers to
strings. For example, if you wish to display a
CAN packet of type 41 (hex) as "Headlights
On", then enter "41" in the first column of
the file and "Headlights On" in the second.

This button creates a sample spreadsheet file
to which you can add your own list of
number-string pairs.

Start from... Use this button to enter a condition that OMEGASCOPE™ will wait for
before collecting data. When OMEGASCOPE™ detects a packet that
matches this condition, it will collect all subsequent data (subject to
filtering, if used - see above) and display it in the table.

Filter Click to show the filter bar, which allows you to enter arbitrary data
above each column in the table. The table will display only those
packets that match the data you have entered. For example,
entering "6C7" in the filter box at the top of the ID column will
cause only frames with an ID of 6C7 to be displayed.

Statistics Toggle the statistics columns that list measurements such as packet
start and end times, and signal voltages.

Search Search for any data value in a specified column of the table.

Refresh Instructs OMEGASCOPE™ to decode the raw data again. This is
necessary if you have changed the Start from... condition, for
example.

Clear Clear all data and settings in the table. New data will appear the
next time that the scope captures a waveform.
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6.5.4.2 Bit Definitions dialog

Location: Serial Decoding dialog  > RS232/UART format > Bit Definitions

Purpose: sets up parameters of your RS232 data format so OMEGASCOPE™ can
decode the data

Signal Idle
State:

The state, low or high, of the signal when no data present.

Data bits: The number of bits in the word.

Parity: The type of error-correction bit, if any, added to each word.

Stop bits: The number of extra bits used to indicate the end of a word.

Bit Order: Whether the least-significant or the most-significant bit occurs first.
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6.5.4.3 Settings dialog

Location: Serial Decoding dialog  > select SPI format > Settings 

Purpose: sets up parameters of your SPI data format so OMEGASCOPE™ can
decode the data 

Sample Clock on: Which edge of the clock to use.

Chip Select State: The polarity of the chip select (CS) signal, if used.

Data bits: The number of bits in the word. Choose from the drop-down
list or type a number directly into the box.

Bit Order: Whether the least-significant or the most-significant bit
occurs first.
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6.5.4.4 I2C Settings dialog

Location: Serial Decoding dialog  > select I2C format > Settings

Purpose: sets up parameters of your I2C data format so OMEGASCOPE™ can
decode the data

Display Address as: 7 bit Slave Address: displays as an 8-bit number by adding
leading zeroes to the 7-bit address.
8 bit Read/Write Address: displays as an 8-bit number
considering the Read/Write~ bit.

75
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6.5.5 Alarms dialog
Location: Tools  > Alarms

Purpose: gives access to the alarms feature, which specifies actions to be taken
on various events

Event: Select the event that will trigger the alarm:

Capture: when a waveform is captured. If triggering  is
enabled, this option corresponds to a trigger event. You can
therefore use this function to save a file on each trigger event.

Buffers Full: when the number of waveforms in the waveform
buffer  reaches the maximum waveform count .

Mask(s) Fail: when any channel fails a mask test .

(Actions list): Add an action to this list by clicking Add. Whenever the specified
event occurs, OMEGASCOPE™ will execute the all the actions in
the list from top to bottom. 

NOTE: For an action to execute, its check box must be
set.

Apply: Set up the scope according to the settings in this dialog.

Add: Add an event to the Actions list. Possible events are:

Beep: activate the computer's built-in sounder. 64-bit PCs
redirect this sound to the headphone output.

Play Sound: specify the name of a .wav sound file to play.
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Stop Capture: equivalent to pressing the red Stop button.

Restart Capture: equivalent to pressing the green Start button.
Use only if the Stop Capture action was used earlier in the list.

Run Executable: run the specified EXE, COM or BAT program
file. You can type the %file% variable after the program name to

pass the name of the last file saved as an argument to the
program. OMEGASCOPE™ will stop capturing while the program
runs, and resume after the program terminates.

Save Current Buffer: save the current waveform from the
buffer as a .psdata, .pssettings, .csv or .mat file. You can

use the %buffer% variable to insert the buffer index number into

the filename, or the %time% variable to insert the time of capture.

Save All Buffers: save the entire waveform buffer as a .psdata,

.pssettings, .csv or .mat file.
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6.5.6 Masks menu
Location: Tools  > Masks

Purpose: gives control over Mask Limit Testing

Add Masks: Add a mask to the display using the Mask Library dialog .

Clear Mask: Remove the mask from the display.

Save Mask: Save the displayed mask to disk as a .mask file.

6.5.6.1 Mask Library dialog

Location: Menu bar  > Tools  > Masks

Purpose: allows you to create, export and import masks for Mask Limit Testing

Channel: Select the channel to which you want to apply the mask.

Available
masks:

The Library section shows all the masks that you have saved in the
past and not deleted. The Loaded section shows all the masks
currently in use.

Generate: Create a new mask based on the last waveform captured from the
selected channel. Opens the Generate Mask dialog .

Import: Load a mask that has previously been saved as a .mask file.

Export: Save a mask as a .mask file for future import.
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Apply: Use the selected mask on the selected channel but remain in the Mask
Library dialog.

OK: Use the selected mask on the selected channel and return to the scope
view .

6.5.6.2 Editing a mask

To edit a mask in Mask Limit Testing  mode, first note that a mask is made up of
one or more shapes called polygons. Choose the polygon that you wish to edit, then
right-click on it and select Edit Mask:

OMEGASCOPE™ will then draw edit handles on the selected mask polygon and display
the mask edit box. If you drag any of the handles to edit the polygon, the statistical
results will be updated immediately.

The mask edit box looks like this:

Normal view
Minimized

view

If the edit box is not immediately visible, it may have been minimized; in which case,

click the restore button: . If you edit the coordinates of a vertex, the statistical
results will be updated immediately. You can also export the mask to a .mask file with

the export button: . Use the + and - buttons to add or remove vertices. The
minimize button has its usual function. To leave mask editing mode, close the mask
edit box with the close (X) button.
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To add or remove an entire polygon, right-click the mask and select either the Add
Mask Polygon or the Remove Mask Polygon command:

6.5.6.3 Generate Mask Dialog

Location: Mask Library dialog  > Generate

Purpose: allows you to set parameters for the automatically generated mask.
OMEGASCOPE™ will then create a new mask based on the last captured
waveform

Name: OMEGASCOPE™ automatically chooses a name for the new mask, but
you can change it to anything you like here.

X Offset: The horizontal distance between the waveform and the mask.

Y Offset: The vertical distance between the waveform and the mask.
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6.5.7 Macro Recorder
Location: Tools  > Macro Recorder

Purpose: records a sequence of commands to be replayed later

The Macro Recorder helps when you wish to execute a series of commands
repeatedly. It saves all commands to a .psmacro file, which can be modified using an
XML editor.

Execute in real
time:

Play back the macro at the same speed as when recorded. Without
this option, playback will be as fast as possible.

47
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6.5.8 Preferences dialog
Location: Menu bar  > Tools  > Preferences

Purpose: Allows you to set options for the OMEGASCOPE™ software. Click one of
the tabs in the picture below to learn more.
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6.5.8.1 General page

Location: Preferences dialog

Purpose: contains general controls for OMEGASCOPE™

Reset 'Don't show this again' dialogs
Restore any missing dialogs that you asked OMEGASCOPE™ not to show again.

Reset preferences
Set all preferences back to their default values.

Waveform Buffer
Maximum Waveforms: This is the maximum number of waveforms that
OMEGASCOPE™ will store in the waveform buffer . You can select a number from
1 to the maximum allowed by the oscilloscope that is connected: see the scope
specifications for details). The actual number of waveforms stored depends on the
available memory and the number of samples in each waveform.

Collection Time Units
Change the mode of the Timebase control in the Capture Setup toolbar .

Times per division: the Timebase control displays time units per division - for
example, '5 ns /div'. Most laboratory oscilloscopes display timebase settings in this
way.

Total collection time: the Timebase control displays time units for the entire
width of the scope view - for example, '50 ns'.

Measurement Statistics
Capture Size - the number of successive captures that OMEGASCOPE™ uses to
calculate the statistics in the Measurements Table . A larger number produces
more accurate statistics but causes them to be updated less frequently.
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6.5.8.2 Power management page

Location: Preferences dialog

Purpose: controls features of the oscilloscope that affect its power consumption

Capture Rate

This control limits the speed at which OMEGASCOPE™ captures data from the scope
device. The other OMEGASCOPE™ settings, the type of scope device  and the speed
of the computer will all affect whether this limit can actually be reached.
OMEGASCOPE™ automatically selects the appropriate limit according to whether your
computer is running on batteries or on mains (line) power.

The settings are in captures per second. By default, the capture rate is set to
"Unlimited" when your computer is running on Mains (line) power, for maximum
performance. If other applications run too slowly on your PC while OMEGASCOPE™ is
capturing, then reduce the capture rate limit. When your computer is running on 
Battery power, OMEGASCOPE™ imposes a performance limit to save the battery. You
can increase this limit manually, but this will cause the battery power to drain very
quickly.
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6.5.8.3 Sampling page

Location: Preferences dialog

Purpose: controls the sampling behaviour of the oscilloscope

Slow Sampling Transition

In normal (fast) sampling mode, OMEGASCOPE™ collects enough data to fill the
screen and then redraws the whole view at once. This method is suitable for fast
timebases, when the screen is redrawn many times each second, but with slow
timebases it can cause a unacceptable delay before the data appears on the
screen. To avoid this delay, OMEGASCOPE™ automatically switches to slow
sampling mode, in which the scope trace advances gradually across the screen as
the scope captures data.

The Collection Time control lets you select the timebase at which OMEGASCOPE™
switches to slow sampling mode.

Slow Sampling Display

When this box is checked, OMEGASCOPE™ displays the previous waveform in the
buffer while gradually redrawing the new waveform over the top of it. Thus, at any
time, the left-hand side of the view shows the beginning of the new waveform,
while the right-hand side shows the end of the previous waveform. A vertical bar
separates the two waveforms.

89
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Sin(x)/x Interpolation

When the number of pixels across the scope view is greater than the number of
samples in the waveform buffer, OMEGASCOPE™ interpolates - that is, it fills the
space between the samples with estimated data. It can either draw straight lines
between the samples (linear interpolation) or connect them with smooth curves
(sin(x)/x interpolation). Linear interpolation makes it easier to see where the
samples are, which is useful for high-accuracy measurements, but results in a
jagged waveform. Sin(x)/x interpolation gives a smoother waveform but disguises
the true locations of the samples, so should be used with care when the number of
samples on the screen is low.

You can adjust the number of samples below which sin(x)/x interpolation is
switched on. Sin(x)/x interpolation is used only on the scope's fastest timebase.
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6.5.8.4 Keyboard page

Location: part of the Preferences dialog

Purpose: displays, and allows you to edit, keyboard shortcuts

A keyboard shortcut is a combination of keys that can be pressed on the keyboard to
activate an OMEGASCOPE™ function.

Keyboard Shortcuts All available OMEGASCOPE™ operations and their
associated keyboard shortcuts (if defined) are listed. To
edit or add a keyboard shortcut:

Scroll the list of OMEGASCOPE™ commands until the
required command is visible.
Select the required command.
Select the 'Press shortcut keys:' box.
Press the required key combination on the keyboard.
Click Assign.

89
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6.5.8.5 Regional & Language page

Location: part of the Preferences dialog

Purpose: lets you select the language and other location-dependent settings for
OMEGASCOPE™'s user interface

Language Select, from the drop-down box, the language you wish to
use for the OMEGASCOPE™ user interface.
OMEGASCOPE™ will ask you to restart the program before
switching to the new language.

Measurement System Select metric or U.S. units.
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6.5.8.6 Printing page

Location: part of the Preferences dialog

Purpose: lets you enter the details that will appear at the bottom of printed
output

Default Print
Settings

When you print a view from the File menu , these details will be
added to the bottom of the page. 
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6.5.8.7 Colors page

Location: part of the Preferences dialog

Purpose: lets you set the colors for various parts of the user interface

Custom Colors

These controls let you specify the colors for various parts of the OMEGASCOPE™
screen:

Channels the trace color for each scope channel

Masks the mask areas in Mask Limit Testing

Misc miscellaneous items:

Grid lines the horizontal and vertical lines on the graticule

Background the area behind the waveforms and graticule. (In persistence
mode  this setting can be overridden by the Persistence
Options dialog .)

Live trigger the trigger marker  for the current trigger position

Trigger secondary trigger marker (appears when the live trigger has
moved since the last waveform capture)

Horizontal axis the numbers across the bottom of each view , which usually
indicate time measurements

Rulers the horizontal and vertical rulers  that you can drag into
position to help measure features on the waveform

Persistence the three colors to use for each channel in digital color 
persistence mode . The top color is used for the most
frequently hit pixels, the middle and bottom colors for the less
and least frequently hit pixels.
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Line Thickness

These controls let you specify the thickness of the lines drawn on the scope  and
spectrum  views:

Channel the waveforms and spectrum traces for all scope channels
Grid Lines the horizontal and vertical lines on the graticule
Markers the horizontal and vertical rulers  that you can drag into

position to help measure features on the waveform

Reset Colors to Default

Resets all of the color and line thickness settings to their default values.
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6.5.8.8 Options page

Location: part of the Preferences dialog

Purpose: lets you set various options that control the way that OMEGASCOPE™
works

Device Startup Settings

Remember Last Device. This option is used when OMEGASCOPE™ finds more than
one scope device connected to the computer. If the check box is ticked,
OMEGASCOPE™ will attempt to use the same device that was used last time.
Otherwise it will use the first device available.

Advanced Features

The advanced capture modes  are enabled by default. You can enable or disable
these features using the following options:

Spectrum Spectrum view  and spectrum analyser  features
Persistence Digital Color, Analog Intensity and custom persistence display

modes
Zoom Overview A window that appears when you zoom in , to help to move

around large waveforms with the minimum of mouse clicks
RPM Revolutions per minute, displayed alongside hertz in the

frequency legend
Trigger Delay The time-delay control in the Triggering toolbar .
Rapid Trigger The 'Rapid' entry in the Trigger mode control in the Triggering

toolbar .

Recent Files

The maximum number of files listed in the File  > Recent Files menu. Click the
button to clear the list.
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6.6 Help menu
Location: Menu bar  > Help  

Purpose: gives access to the OMEGASCOPE™ User's Guide and related
information 

User's Guide This is the main help manual, containing complete information on
the program. Contents, Index and Search are shortcuts to
various functions of the help viewer.

Check for
Updates

Connect to the Omega Engineering, Inc. website and look for a
newer version of the OMEGASCOPE™ software. Requires an internet
connection.

About
OMEGASCOP
E™

Show version numbers of the OMEGASCOPE™ software and any
oscilloscope that is connected.
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6.7 Connect Device dialog
Location: Menu bar  > File  > Connect Device

or plug in a new device

Purpose: when OMEGASCOPE™ finds more than one available scope device ,
this dialog allows you to select which one to use 

See "How to change to a different device " if you wish to switch to a different scope
device later.

Procedure

To restrict the selection to a particular series of devices, click on the device drop-
down box and select a device series; otherwise, click the Find All button.
Wait for a list of devices to appear in the grid.
Select one device and click the OK button.
OMEGASCOPE™ will open a scope view  for the selected scope device.
Use the toolbars  to set up the device and the scope view  to display your
signals.

Demonstration mode

If you start OMEGASCOPE™ with no device connected, or with more than one device
connected, the Connect Device dialog automatically appears with a list of
'DEMO' (demonstration) devices for you to choose from. These are virtual devices
that you can use to experiment with the features of OMEGASCOPE™. Once you have
selected a demonstration device and clicked OK, OMEGASCOPE™ adds a Demo Signal
Generator button  to the toolbar. Use this button to set up the test signals from
your demonstration device.
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6.8 Converting files in Windows Explorer
You can convert OMEGASCOPE™ data files to other formats for use in other
applications, or to different forms of data for use with OMEGASCOPE™.

The easiest way to do this conversion is through the context menu in Windows
Explorer. The context menu is the menu that pops up when you right-click it with the
mouse or activate it with the "menu" button on a Windows keyboard. When you install
OMEGASCOPE™, a "Convert" entry is added to the context menu to enable you to
convert OMEGASCOPE™ data files.

The OMEGASCOPE™ context menu in Windows Explorer

Converting to OMEGASCOPE™ 6.2.4 format

The example above shows four pre-existing OMEGASCOPE™ data files represented by
standard OMEGASCOPE™ icons. OMEGASCOPE™ 6.2.4 introduced a new feature that
allows OMEGASCOPE™ data files to appear as waveforms instead of icons. To enable
this feature for old data files, you need to convert them to the new format using the
context menu of Windows Explorer.

If OMEGASCOPE™ is running, close it.
In Windows Explorer, right-click a OMEGASCOPE™ data file.

Select Convert > All waveforms > .psdata. A OMEGASCOPE™ icon  will
appear in the Windows notification area while the conversion is in progress.
OMEGASCOPE™ will ask you to confirm that you wish to overwrite the .psdata file
with a new version. Click Yes.
Wait for Windows Explorer to update the display.
Repeat for all .psdata files.
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The .psdata files should now appear as in this picture:

Converting to other formats

For all of these conversions, you can choose either "All waveforms" or "Current
waveform". A .psdata file can contain either a single waveform or the entire contents
of the waveform buffer, which can hold a number of waveforms from successive
trigger events. If the .psdata file contains more than one waveform, then you can
choose to convert all of them or just the one that was last viewed in OMEGASCOPE™.

Right-click an OMEGASCOPE™ data file.
To convert all waveforms in the file, select Convert > All waveforms or Convert
> Current waveform and then the file format that you require. An

OMEGASCOPE™ icon  will appear in the Windows notification area while the
conversion is in progress. 

Complex operations

For more complex operations, such as converting all files in a directory, you can run
OMEGASCOPE™ in a command window (see Command-line syntax ).171
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7 Toolbars and buttons
A toolbar is a collection of buttons and controls with related functions.
OMEGASCOPE™ contains the following toolbars:

Buffer Navigation toolbar
Channel Setup toolbar
Measurements toolbar
Capture Setup toolbar
Start / Stop toolbar
Triggering Toolbar
Zooming and Scrolling toolbar
Signal Generator button
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7.1 Buffer Navigation toolbar
The Buffer Navigation toolbar allows you to select a waveform from the waveform
buffer.

What is the waveform buffer?

Depending on the settings you have chosen, OMEGASCOPE™ may store more than
one waveform in its waveform buffer. When you click the Start  button or change a
capture setting , OMEGASCOPE™ clears the buffer and then adds a new waveform
to it each time the scope device captures data. This continues until the buffer is full or
you click the Stop  button. You can limit the number of waveforms in the buffer to a
number between 1 and 10,000 using the General preferences  page.

You can review the waveforms stored in the buffer using these buttons:

First waveform button. Display waveform 1.

Previous waveform button. Display the previous waveform in the
buffer.

Waveform number indicator. Show which waveform is currently
displayed, and how many waveforms the buffer holds. You can edit the
number in the box and press Enter, and OMEGASCOPE™ will jump to the
specified waveform.

Next waveform button. Display the next waveform in the buffer.

Last waveform button. Display the last waveform in the buffer.

Buffer Navigator button. Open the Buffer Navigator window  for
quick selection of buffer waveforms.
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7.2 Channel Setup toolbar
The Channel Setup toolbar controls the settings for each vertical input channel .
The screen shot below shows the toolbar for a two-channel scope device , but
different scope devices may have different numbers of channels.

Each channel has its own set of buttons:

Channel Options button. Opens the Channel Options menu
with options for probes,  resolution enhancement , scaling
and filtering.

Range control. Sets up the scope device to capture signals over
the specified range of values. The list of options depends on the

selected scope device  and probe . A red warning symbol - 
- appears if the input signal exceeds the selected range. If you
select Auto, OMEGASCOPE™ will continually adjust the vertical
scale so that the height of the waveform fills as much of the view
as possible. 

Coupling Control. Sets up the input circuitry.
AC coupling : rejects frequencies below about 1 Hz. 
DC coupling : accepts all frequencies from DC to the scope's
maximum bandwidth.
Frequency: enable the built-in frequency counter if available.
Only one channel at a time can be operated in this mode.
Supported devices include the OMSP-4000 Series 12-bit scopes.

173

174

107

174 19 109

174 174

173

173



OMEGASCOPE™ User's Guide 107

 M5064

7.2.1 Channel Options menu
The Channel Options menu appears when you click the Channel Options button

(for example: ) on the Channel Setup toolbar .

Probe list. Indicates the probe currently in use and
allows you to select a different one. Use it to tell
OMEGASCOPE™ what type of probe is connected to
a channel. By default, the probe is assumed to be
x1, which means that a one-volt signal at the input
to the probe will appear as one volt on the display.

Expand probe list. Click this to select from a list
of probes.

Open Custom Probes dialog. The Custom Probes
dialog  allows you to edit your library of custom
probes.

Resolution enhance. Allows you to increase the
effective resolution of your scope device using 
Resolution enhancement . The number in this
box is a target value that the software will attempt
to use whenever possible.

Axis Scaling. These are the axis scaling controls
 that allow you to set the scale and offset for

each vertical axis individually.
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Analog Options. Options that can be applied to
the oscilloscope input hardware, if the oscilloscope
hardware supports them.

Offset: an offset voltage added to the analog input
before digitization. OMSP-3000 Series only.

Lowpass Filtering. An independent digital lowpass
filter  for each input channel, with programmable
cut-off frequency. This can be useful for removing
noise from your signal to make more accurate
measurements. Not all scopes support this feature.
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7.2.1.1 Axis scaling controls

The axis scaling controls are control boxes that let you change the scale and offset
of each vertical axis individually. If the axis belongs to a reference waveform  then
you can also adjust its delay relative to the live waveforms.

Controls for a live
waveform

Controls for a reference
waveform

There are two ways to open the axis scaling control: -

For any channel displayed in a view : click the coloured scaling button ( ) at
the bottom of the vertical axis
For any input channel: Click the Channel Options button  in the Channel
Setup toolbar

Scale control. Increase to magnify the waveform, decrease to reduce
it. The vertical axis rescales accordingly so that you can always read the

correct voltage from the axis. Click the reset button ( ) to return to a
scale of 1.0. The scaling button always shows the selected scale.

Offset control. Increase to move the waveform up the display,
decrease to move it down. The vertical axis shifts accordingly so that
you can always read the correct voltage from the axis. Adjusting this
control is equivalent to clicking and dragging the vertical axis. Click the

reset button ( ) to return to an offset of 0.00%.

Delay control (for reference waveforms only). Increase to move
the waveform to the left relative to the timing reference point, decrease

to move it to the right. Click the reset button ( ) to return to a delay
of 0 s. 

The location of the timing reference point depends on which trigger
mode  OMEGASCOPE™ is in. If the trigger mode is None then the
delay is measured relative to the left-hand edge of the display. In all
other trigger modes, the delay is measured relative to the trigger
marker. 
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7.2.1.2 Lowpass filtering

The lowpass filtering feature can reject high frequencies from any selected input
channel. The filtering control is found in the Advanced Channel Options dialog ,

which is opened by clicking the Channel Options button ( ) for the relevant
channel on the Channel Setup toolbar . The control determines the cut-off frequency
of the filter, which must be below half the sampling rate shown in the Properties sheet

.

The following devices support lowpass filtering:

OMSP-3000 Series
OMSP-4000 Series

Lowpass filtering is useful for rejecting noise. The split screenshot below shows the
effect of applying a 1 kHz lowpass filter on a noisy signal. The underlying shape of the
signal is preserved but the high-frequency noise is eliminated:

Left: before lowpass filtering.  Right: after 1 kHz lowpass filtering.
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Filter details

The lowpass filtering algorithm is chosen according to the relationship between the
selected cut-off frequency (fC) and the sampling rate (fS), as follows:

fC / fS Filter type Description

0.0 to 0.1 Moving average A moving average filter is used for low cut-off
frequencies. The length of the filter is adjusted to
achieve the selected cut-off frequency, which is is
defined as the first minimum in the frequency
response. There is significant signal leakage above
the cut-off frequency. This filter changes a vertical
edge into a linear slope.

0.1 to < 0.5 FIR A finite impulse response filter is used for medium
to high cut-off frequencies. This has a monotonic
roll-off above the cut-off frequency and therefore
suffers from less leakage than the moving average
filter.

You can force OMEGASCOPE™ to use one or other of the filter types by adjusting the 
Samples control in the Capture Setup toolbar  to make the ratio fC/fS fall into one

of the two ranges shown in the table. As the table shows, the cut-off frequency must
be below half the sampling frequency.
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7.3 Capture Setup toolbar
The Capture Setup toolbar controls the time-related or frequency-related settings of
your oscilloscope.

Scope Mode

In scope mode,  the toolbar looks like this:

(See below for different versions of the toolbar in spectrum mode  and persistence
mode .)

Scope Mode. Sets up OMEGASCOPE™ to operate as an oscilloscope
. Use the Auto Setup button to optimise the settings. If you

wish, you can add a secondary spectrum view  from the context
menu (by right-clicking on the scope view).

Persistence Mode. Toggles persistence mode , which allows old
traces to remain on the screen in faded colors while new traces are
drawn on top in brighter colors. The use of colors is controlled by
the Persistence Options dialog. OMEGASCOPE™ will remember
any views that were open, so that you can return to them by clicking
the Persistence Mode button again.

Spectrum Mode. Sets up OMEGASCOPE™ to operate as a spectrum
analyser . Use the Auto Setup button to optimise the settings. If
you wish, you can add a secondary scope view  from the context
menu (by right-clicking on the scope view).

Auto Setup. Searches for a signal on one of the enabled input
channels, then sets up the timebase and signal range to display the
signal correctly.

Home. Restores OMEGASCOPE™ to its default settings. Equivalent
to the File  > Startup Settings > Load Startup Settings
command.

Timebase control. Sets the time represented by a single division of
the horizontal axis when the horizontal zoom control is set to x1.
The timebases available depend on the type of scope device  you
are using.

Choosing a timebase of 200 ms/div or slower causes
OMEGASCOPE™ to switch to a different mode of data transfer. The
internal details of this are taken care of by OMEGASCOPE™, but the
slow mode limits the sampling rate to a maximum of 1 million
samples per second.

You can change this control to display the total time across the
scope view, rather than the time per division, using the Collection
Time Units control in the General  page of the Preferences dialog

.
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Horizontal zoom control. Zooms the view, in the horizontal

direction only, by the specified amount. Click the  and  buttons

to adjust the zoom factor, or the  button to reset.

Samples control. Sets the maximum number of samples that will
be captured for each channel. If this is larger than the number of
pixels across the scope view then you can zoom in to see more
detail. The actual number of samples captured is displayed on the 
Properties sheet,  and may be different from the number
requested here, depending on which timebase is selected and which
scope device is in use.

Spectrum Mode

In spectrum mode,  the Capture Setup toolbar looks like this:

Frequency range control. Sets the frequency range across the
horizontal axis of the spectrum analyser when the horizontal zoom
control is set to x1.

Spectrum Options. Appears if a spectrum view  is open,
regardless of whether scope mode  or spectrum mode  is
selected. It opens the Spectrum Options dialog .

Persistence Mode

In persistence mode,  the Capture Setup toolbar looks like this:

Persistence Options. Opens the Persistence Options dialog ,
which controls several parameters affecting the way that
OMEGASCOPE™ represents old and new data in persistence mode.
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7.3.1 Spectrum Options dialog
This dialog appears when you click the Spectrum Options button in the Capture
Setup toolbar . It is available only when a spectrum view  is open. It contains
controls that determine how OMEGASCOPE™ converts the source waveform in the
current scope view to a spectrum view.

Spectrum 
Bins

The number of frequency bins into which the spectrum is
divided. This control sets the maximum number of frequency
bins, which the software may or may not be able to provide
depending on other settings. The main constraint is that the
number of bins cannot greatly exceed half the number of
samples in the source waveform.

If the source waveform contains fewer samples than required
(that is, fewer than twice the number of frequency bins), then
OMEGASCOPE™ zero-pads the waveform up to the next power of
two. For example, if the scope view contains 10,000 samples,
and you set Spectrum Bins to 16384, then OMEGASCOPE™ zero-
pads the waveform to 16,384 samples, which is the nearest
power of two above 10,000. It then uses these 16,384 samples
to provide 8,192 frequency bins, not the 16,384 requested.

If the source waveform contains more samples than required,
then OMEGASCOPE™ uses as many samples as necessary,
starting from the beginning of the waveform buffer. For
example, if the source waveform contains 100,000 samples and
you request 16,384 frequency bins, OMEGASCOPE™ needs only
2 x 16,384 = 32,768 samples, so it uses the first 32,768
samples from the waveform buffer and ignores the rest. The
amount of data actually used is displayed as the Time Gate
setting in the Properties sheet.

Window 
Function

Allows you to choose one of the standard window functions to
reduce the effect of operating on a time-limited waveform. See 
Window functions.

Display 
Mode

You can choose Magnitude, Average or Peak Hold.

Magnitude: the spectrum view shows the frequency spectrum
of the last waveform captured, whether live or stored in the 
waveform buffer.
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Average: the spectrum view shows an rolling average of spectra
calculated from all the waveforms in the waveform buffer .
This has the effect of reducing the noise visible in the spectrum
view. To clear the averaged data, click Stop  and then Start,

 or change from Average mode to Magnitude mode.

Peak Hold: the spectrum view shows a rolling maximum of the
spectra calculated from all the waveforms in the buffer. In this
mode, the amplitude of any frequency band in the spectrum
view will either stay the same or increase, but never decrease,
over time. To clear the peak hold data, click Stop  and then
Start,  or change from Peak Hold mode to Magnitude mode.

Note: when you switch to Average or Peak Hold mode, there
may be a noticeable delay while OMEGASCOPE™ processes the
entire contents of the waveform buffer, which may contain many
waveforms, to build up the initial display. If this occurs, a
progress bar appears at the bottom of the window to show that
OMEGASCOPE™ is busy:

Scale Specifies the labelling and scaling of the vertical (signal) axis.
This can be one of the following:

Linear: The vertical axis is scaled in volts.

Logarithmic: The vertical axis is scaled in decibels,
referred to the level selected below in the 
Logarithmic unit control.

dBV: Reference level is 1 volt.

dBu: Reference level is 1 milliwatt with a
load resistance of 600 ohms. This
corresponds to a voltage of about 775 mV.

dBm: Reference level is one milliwatt into
the specified load impedance. You can
enter the load impedance in the box below
the Logarithmic unit control.

Arbitrary dB: Reference level is an
arbitrary voltage, which you can specify in
the box below the Logarithmic unit
control.
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7.3.2 Persistence Options dialog

This dialog appears when you click the Persistence Options button  in the
Capture Setup toolbar . It is available only when persistence mode  is selected.
It controls the colors and fading algorithm used to distinguish new or frequent data
from old or intermittent data in the persistence view.

Mode Digital Color. This mode uses a range of colors to indicate the
frequency of waveform data. Red is used for the most frequent data,
and less frequent data is represented successively by yellow and blue.

Analog Intensity. This mode uses color intensity to indicate the age of
waveform data. The latest data is drawn at full intensity in the selected
color for that channel, with older data being represented by paler
shades of the same color.

Advanced. This mode opens up a Custom Options section at the
bottom of the dialog that let you customise the persistence mode
display.

Decay Time The time, in milliseconds, taken for waveform data to fade from
maximum intensity to minimum intensity or from red to blue. The
longer the decay time, the longer the older waveforms will remain on
the screen.

Saturation The intensity or color with which new waveforms are drawn.

Decayed
Intensity

The intensity or color to which the oldest waveforms decay when the
decay time expires. If the decayed intensity is zero, then older
waveforms will be completely erased from the display after the decay
time. For non-zero values of decayed intensity, old waveforms will
remain indefinitely on the screen at that intensity unless overwritten by
new ones.
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Custom Options

Line DrawingThe type of line drawn between samples that are adjacent in time.
Phosphor Emulation. Joins each pair of sample points with a line
whose intensity varies inversely with the slew rate.
Constant Density. Joins each pair of sample points with a line of
uniform color.
Scatter. Draws sample points as unconnected dots.

Color
Scheme

Phosphor. Uses a single hue for each channel, with varying intensity.
Color. Uses a color from red to blue to represent the age of each
waveform.

Background Black. Overrides the Color Preferences dialog . This is the default.
White. Overrides the Color Preferences dialog .
User Preference. Sets the background color to the preference set in
the Colors  page of the Preferences dialog .

Data Hold This option is enabled only when Persistence Mode (see below) is set
to Time Delay.

Decay Timeout. Old waveforms fade until they reach Decayed
Intensity and then disappear.
Infinite. Old waveforms fade until they reach Decayed Intensity and
then remain indefinitely unless overwritten by new waveforms.

Persistence
Mode

Frequency. Points on the display are drawn with a color or intensity
that depends on the frequency with which they are hit by waveforms.
Time Delay. Points on the display are drawn at full intensity when hit
by a waveform, and are then allowed to decay to Decayed Intensity.
The behaviour after this depends on the Data Hold setting (see above)
.
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7.4 Measurements toolbar
The Measurements toolbar controls the measurements table . 

It contains the following buttons:

Add Measurement Adds a row to the table, and then opens the Add
Measurement dialog.

Edit Measurement Opens the Edit Measurement dialog  for the currently
selected measurement. You can also edit a
measurement by double-clicking on a row of the 
measurements table.

Delete Measurement Deletes the currently selected row from the 
measurements table .
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7.5 Signal Generator button
The Signal Generator button allows you to set up your scope device's  test signal
generator, if it has one, or the demo signal settings if OMEGASCOPE™ is in demo
mode .

If your scope has a built-in signal generator then clicking the Signal Generator
button opens the Signal Generator dialog .

If OMEGASCOPE™ is in demo mode  then clicking the Signal Generator button
opens the Demo Signals menu .

7.5.1 Signal Generator dialog
Location:

click the Signal Generator button   on the toolbar

Purpose: controls the scope device's  built-in signal generator

Signal generator dialog for the
OMEGASCOPE™ 3206

Not all scope devices have a signal generator, and those that do have a varying range
of controls in the signal generator dialog.

Basic controls

Signal On. Tick this box to enable the signal generator.

Signal Type. Select the type of signal to be generated. The list
of signal types  depends on the capabilities of the scope
device.
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Import. Opens a file selection dialog that allows you to import
an arbitrary waveform file . The file will be loaded into the
arbitrary waveform generator  and the generator switched on.
This button is available only if your scope has an arbitrary
waveform generator .

Arbitrary. Opens the Arbitrary Waveform window . This
button is available only if your scope has an arbitrary waveform
generator .

Start Frequency. Type in this box or use the spin buttons to
select the frequency. If the scope device has a frequency sweep
generator, then this box sets the start frequency of the sweep.

Amplitude. The amplitude of the waveform measured from
peak to peak. For example, if Amplitude is 1 V and Offset is 0
V, the output will have a negative peak of -0.5 V and a positive
peak of +0.5 V.

Offset. The mean value of the signal. For example, when Offset
is 0 V, a sine or square wave will have equal positive and
negative peak voltages.

Sweep mode controls

Active. Tick this box to enable sweep mode. If the box is not
ticked, the generator will operate at a fixed frequency set by
the Start Frequency control.

Sweep Type. Specifies the direction in which the frequency is
swept.

Stop Frequency. In sweep mode, the generator stops
increasing the frequency when it reaches the Stop Frequency.

Frequency Increment. In sweep mode, the generator
increases or decreases the frequency by this amount every 
Increment Time Interval.

Increment Time Interval. In sweep mode, the generator
increases or decreases the frequency by Frequency Increment
each time this interval ends.
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7.5.2 Arbitrary waveform files
Some OMEGASCOPE™ PC Oscilloscopes have an arbitrary waveform generator
(AWG), which is enabled using the Signal Generator dialog . OMEGASCOPE™ can
program the AWG with a standard waveform, such as a sine or square wave, or an
arbitrary waveform that you create or import from a text file.

A text file for OMEGASCOPE™ is a list of decimal floating-point values, as in this
example:

0.0
0.3
0.9
0.6
0.6
0.0
-0.3
0.0
0.0
0.0

The file may have between 10 and 8,192 values, as many it needs to define the
waveform. Each line may have more than one value, in which case the values must be
separated by tabs or commas.

The values are samples between -1.0 and +1.0 and must be equally spaced in time.
The output is scaled to the amplitude selected in the Signal Generator dialog.  and
the selected offset is added if necessary. For example, if the signal generator
amplitude is set to "1 V" and the offset to "0 V", then a sample value of -1.0
corresponds to an output of -1.0 V and a sample of +1.0 corresponds to an output
of +1.0 V.

The file should contain exactly one cycle of the waveform, which will then be played
back at the speed specified in the Signal Generator dialog . In the example above,
the signal generator was set to 1 kHz, so one cycle of the waveform lasts for 1 ms.
There are 10 samples in the waveform, so each sample lasts for 0.1 ms.

Using files saved from OMEGASCOPE™

As OMEGASCOPE™ can export CSV and TXT files , you can capture a waveform and
then play it back using the arbitrary waveform generator. You must first modify the
file by removing the header rows and time values so that its format matches the
example above.
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7.5.3 Arbitrary Waveform Generator window
Location: Signal Generator dialog  > Arbitrary

Purpose: allows you to import, edit, draw and export arbitrary waveforms to load
into your scope's arbitrary waveform generator . You can also import
and export the data in CSV format  for use in other applications. 

 

Once the desired waveform appears in the window, click OK or Apply to start using it.

Toolbar buttons

Import from channel. Opens the Import from Channel
dialog , which lets you copy a waveform from the scope
into the arbitrary waveform window.

Import. Displays an Open dialog to allow you to import an
arbitrary waveform from a text file .

Export. Displays a Save As dialog to allow you to save the
arbitrary waveform as a text file .

Freehand drawing. Enters freehand drawing mode. in
which you can draw any waveform shape using the mouse.

Straight-line drawing. Enters straight line mode, in which
you can click on the waveform to draw a straight line from
the previous point. To start a new series of lines, click the
button again.

Samples. The number of samples in the arbitrary
waveform. Each sample represents the signal value at a
given instant in time, and the samples are equally spaced in
time. For example, if there are 1024 samples and the 
arbitrary waveform generator  is set to play back at 1
kHz, then each sample represents (1/1 kHz ÷ 1024) or
about 0.98 microseconds.
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Bit stream. Draws a sequence of bits according to binary or
hex data that you specify. The logic high and low levels are
adjustable.

Clear. Deletes the arbitrary waveform.

Normalize. Adjusts the waveform vertically so that it
occupies the full [-1,+1] range.

Undo and Redo. The Undo button reverses the last
change made to the arbitrary waveform. The Redo button
reverses the last action of the Undo button.

Zoom tools. To zoom the time axis in or out, click the "+"
or "-" zoom button and then click on the waveform area.
Click the "100%" button to restore the time axis to its
original scale.

Waveform settings

Standard waveform shapes. Draw a standard waveform
with the settings specified in the numerical controls below
the toolbar. The current waveform will be erased.

Cycles. The number of cycles to draw. This control is used
in conjunction with the Standard waveform shapes
buttons. Select one of the standard waveform shapes and
then enter the number of cycles, and OMEGASCOPE™ will
draw the requested number of cycles of the waveform. 

Minimum. When one of the Standard waveform shapes
buttons is pressed, this control sets the minimum signal
level.

Maximum. When one of the Standard waveform shapes
buttons is pressed, this control sets the maximum signal
level.

Duty cycle. When a square, triangular or ramp waveform is
selected using one of the Standard waveform shapes
buttons, this control sets the duty cycle of the signal. Duty
cycle is defined as the time that the signal spends above
zero volts divided by the total cycle time. Thus, a
symmetrical square or triangular wave has a duty cycle of
50%. Reducing the duty cycle shortens the positive part of
the cycle and lengthens the negative part, and increasing
the duty cycle does the opposite.

Other buttons

OK Copies the waveform from the graphical editor into the
arbitrary waveform generator and returns to the main 
OMEGASCOPE™  window.

Apply Copies the waveform from the graphical editor into the
arbitrary waveform generator and remains in the Arbitrary
Waveform Generator window.
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7.5.3.1 Import from a Channel dialog

Location: Arbitrary Waveform window  > Import from a Channel button (

)

Purpose: allows you to copy captured data from a scope channel to the Arbitrary
Waveform window  

Select Channel: You can import the latest waveform from any available channel.

Select Samples: By default, the entire capture is imported. This control allows you
to specify a subset of the capture, either between specified
sample numbers or between rulers. The subset will be scaled to
fit the number of samples specified in the Samples control in
the Arbitrary Waveform window .
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7.5.4 Demo Signals dialog
Location: start OMEGASCOPE™ with no scope device plugged in > Connect

Device dialog  > select "DEMO" device > Signal Generator button

 ( ) > select channel

Purpose: controls one channel of the "demo" signal source, a feature of
OMEGASCOPE™ that creates a variety of test signals to simulate a
scope device 

Signal On: Tick this box to enable the demo signal source.

Frequency: Type your desired frequency in hertz, or use the spin
buttons.

Amplitude: Type your desired amplitude in volts, or use the spin
buttons.

Offset: Enter a number to add a d.c. offset to the demo signal. By
default, the demo signals have a mean value of zero volts.

7.5.5 Demo Signals menu
Location: start OMEGASCOPE™ with no scope connected > Connect Device

dialog  > select "demo device"  > Signal Generator button  (

)

Purpose: allows you to set up test signals so that you can experiment with
OMEGASCOPE™ when no scope device is connected

When you click the Signal Generator button  , a drop-down list of all the
available channels in your demo device appears, like this:

Click one of the channels to open the Demo Signals dialog , which will allow you
to set up a signal from that channel.
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7.6 Start / Stop toolbar
The Start / Stop toolbar allows you to start and stop the scope device . Click
anywhere on the toolbar, or press the space bar, to start or stop sampling.

Start icon.  Highlighted if the oscilloscope is sampling.

Stop icon.  Highlighted if the oscilloscope is stopped.
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7.7 Triggering toolbar
The Triggering toolbar tells the scope device when to start capturing data. See
also: Trigger.

Trigger Mode. The list of available modes varies depending on the
type of scope device  in use.

None: OMEGASCOPE™ acquires waveforms repeatedly without
waiting for a signal to trigger on.

Auto: OMEGASCOPE™ waits for a trigger event before capturing
data. If there is no trigger event within a reasonable time, it
captures data anyway. It repeats this process until you click the 
Stop button . "Auto" mode does not set the trigger level
automatically.

Repeat: OMEGASCOPE™ waits indefinitely for a trigger event
before displaying data. It repeats this process until you click the 
Stop button . If there is no trigger event, OMEGASCOPE™
displays nothing.

Single: OMEGASCOPE™ waits once for a trigger event, then stops
sampling. To make OMEGASCOPE™ repeat this process, click the 
Start  button.

Rapid: OMEGASCOPE™ instructs the scope device  to acquire a
sequence of waveforms with the minimum possible delay between
them. The display is not updated until the last waveform in the
sequence has been captured. When the operation is finished, you
can step through the waveforms using the Buffer Navigation
toolbar .

ETS: Equivalent Time Sampling.  OMEGASCOPE™ captures many
cycles of a repetitive signal, then combines the results to produce a
single waveform with higher time-resolution than is possible with a
single capture. For accurate results, the signal must be perfectly
repetitive and the trigger must be stable.

If you select ETS when an Advanced Trigger  type is enabled, the
trigger type will revert to Simple Edge and the Advanced
Triggering button will be disabled.

Advanced Triggering. Click to open the Advanced Triggering
dialog,  which gives you extra trigger types beyond the simple
edge trigger. If this button is disabled, it is because either None or
ETS is selected in the trigger mode control, or your scope device
does not support this mode. To enable the Advanced Triggering
button, set the control to another trigger mode, such as Auto,
Repeat or Single.

Trigger Source. This is the channel that OMEGASCOPE™ monitors
for the trigger  condition.

Rising Edge. Click to trigger on the rising edge of the waveform.
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Falling Edge. Click to trigger on the falling edge of the waveform.

Trigger Level. Sets the trigger  level. You can also set the
trigger level by dragging the trigger marker  up or down on the
screen.

Pre-trigger Time (0% to 100%). This parameter controls how
much of the waveform appears before the trigger point. It defaults
to 50%, which puts the trigger marker  in the middle of the
screen. You can also control this parameter by dragging the trigger
marker  to the left or right.

Post-trigger Delay Enable. Click this button to toggle the Post-
trigger Delay control (see next item).

Post-trigger Delay. The post-trigger delay is the time that
OMEGASCOPE™ waits after the trigger point before sampling. You
can also modify this parameter by dragging the trigger marker
while the Post-trigger Delay button is enabled. As you drag the
marker, you will see the post-trigger arrow  displayed briefly. For
this control to have an effect, you must first make sure that the 
Post-trigger Delay button is enabled. 

See the reference topic "Trigger Timing " for information on how
the Pre-trigger Time and Post-trigger Delay controls interact.

Rapid Captures. In Rapid trigger mode, this is the number of
waveforms to capture in a sequence. They will be captured with the
minimum possible dead time  between them.
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7.7.1 Advanced Triggering dialog
Location:

Triggering toolbar  > Advanced Triggering button ( )

Purpose: allows you to set up more complex trigger types than simple edge-
triggering 

Advanced trigger types list. This control
lists all the available advanced trigger types
. Click on the condition you require, and a
diagram and description will appear on the
right of the dialog.

If ETS triggering  is enabled in the triggering
toolbar , then selecting any trigger type
except Simple Edge switches off ETS mode.

Advanced triggering options. The options
available depend on the trigger type selected.
See Advanced trigger types . Instructions
and diagrams also appear in the dialog.
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7.7.2 Advanced trigger types
The advanced trigger types can be switched on in the Advanced Triggering
dialog.

For all trigger types, the first step is to select which signal the scope should use as the
trigger; so set Source to either A, B, Ext or AuxIO. These names correspond to the
BNC input connectors on the scope device. Then choose one of the trigger types
below.

Simple Edge. This type provides the same Rising and Falling edge triggers
that are available from the Triggering toolbar . It is included in this dialog as
an alternative method of setting up the Simple Edge trigger.

You can set the trigger Threshold while in the advanced triggering dialog,
or alternatively you can drag the Trigger marker  on the scope view.

This is the only trigger type that is compatible with ETS  mode.

Advanced Edge. This trigger type adds an extra Rising or Falling edge
trigger, and Hysteresis, to the Simple Edge trigger. The Rising or Falling
option triggers on both edges of a waveform, and is useful for monitoring
pulses of both polarities at once. Hysteresis  is described in a separate
topic.

Window. This trigger type detects when the signal enters or leaves a specified
voltage window. The Direction control specifies whether the trigger should
detect the signal entering the window, leaving it, or both. Threshold 1 and
Threshold 2 are the upper and lower voltage limits of the window. The order in
which you specify the two voltages does not matter. Hysteresis  can be set
to reduce the number of false triggers on a noisy signal, and is described in a
separate topic.

Pulse Width. This trigger type detects pulses of a specified width.

First set the Pulse Direction to either Positive or Negative according to the
polarity of the pulse you are interested in.

Next, set one of the four Condition options:

Greater than triggers on pulses wider than the specified time.

Less than triggers on pulses that are narrower (useful for finding
glitches).

Inside time range triggers on pulses that are wider than Time 1 but
no wider than Time 2 (useful for finding pulses that meet a
specification).

Outside time range does the opposite: it triggers on pulses that are
either narrower than Time 1 or wider than Time 2 (useful for finding
pulses that violate a specification).

Next, set the trigger Threshold in volts or other units, or drag the Trigger
marker  on the scope view.

Finally, set up Time 1 (and Time 2 if present) to define the pulse width.
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Interval. This type lets you search for two successive edges of the same
polarity that are separated by a specified interval of time.

First, set the Starting edge to either Rising or Falling according to the
polarity of the edges you are interested in.

Next, select one of the four Condition options:

Greater than triggers when the second edge occurs later than Time 1
after the first edge (useful for detecting missing events).

Less than triggers when the second edge occurs earlier than Time 1
after the first edge (useful for detecting timing violations and spurious
edges).

Inside time range triggers when the second edge is later than Time 1
after the first edge and earlier than Time 2 (useful for finding valid
edges).

Outside time range triggers when the second edge is earlier than
Time 1 after the first edge or later than Time 2 (useful for finding
spurious edges).

Finally, set up Time 1 (and Time 2 if present) to define the time interval.

Window pulse width. This is a combination of the window trigger and the
pulse width trigger. It detects when the signal enters or leaves a voltage range
for a specified period of time.

Level dropout. This detects an edge followed by a specified time with no
edges. It is useful for triggering on the end of a pulse train.

Window dropout. This is a combination of the window trigger and the dropout
trigger. It detects when the signal enters a specified voltage range and stays
there for a specified time. This is useful for detecting when a signal gets stuck
at a particular voltage.

Runt. Detects a pulse that crosses one threshold and then falls below the same
threshold, without crossing the second threshold. This is typically used for
finding pulses that fail to reach a valid logic level.

Logic. This can detect a number of logical combinations of the scope’s four
inputs: A, B, Ext and AUXIO. The conditions that can be applied to each input
vary: A and B can be edge-, level- or window-qualified; Ext is level-qualified
with a variable threshold; and AUXIO is level-qualified with a fixed TTL
threshold.

You can choose to combine the channels with an AND, NAND, OR, NOR, XOR or
XNOR function.
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7.7.2.1 Hysteresis

Hysteresis is a feature of the advanced trigger types  in OMEGASCOPE™ that
reduces false triggering on noisy signals. When hysteresis is enabled, a second trigger
threshold voltage is used in addition to the main trigger threshold. The trigger fires
only when the signal crosses the two thresholds in the correct order. The first
threshold arms the trigger, and the second causes it to fire. An example will help to
illustrate how this works.

Noisy signal with a single threshold

Consider the very noisy signal above. It is difficult to trigger reliably on this signal
with a normal rising edge trigger because it crosses the trigger threshold, the red line
in this picture, several times in one cycle. If we zoom in on the highlighted parts of
the signal, we will see how hysteresis can help.

  

Noisy signal with hysteresis threshold

In these zoomed-in views, the original threshold is the lower red line. The upper red
line is the second threshold used by the hysteresis trigger.

The signal rises across the lower threshold at (1) and (2), arming the trigger but not
firing it. At (3) the signal finally crosses the upper threshold, firing the trigger. On the
falling edge of the signal, at (4) and (5), rising edges of noise pulses cause the signal
to cross the upper and lower thresholds, but in the wrong order, so the trigger is not
armed and does not fire. Thus the trigger occurs at only one well-defined point in the
cycle (3), despite the noise on the signal.

Hysteresis is enabled by default for all the advanced trigger types. The Hysteresis
controls in the Advanced triggering dialog  let you change the hysteresis voltage as

a percentage of full scale. The trigger marker  shows the size of the hysteresis
window.

130

129



OMEGASCOPE™ User's Guide 133

 M5064

7.8 Zooming and Scrolling toolbar
The Zooming and Scrolling toolbar allows you to move around a scope view  or
spectrum view . Each button has a keyboard shortcut, as listed below.

Ctrl+S
or
Esc

Normal Selection tool. Restores the pointer to its normal
appearance. You can use this pointer to click buttons, drag rulers
and operate any other controls in the OMEGASCOPE™ window.

Ctrl+D Hand tool. Turns the pointer into a hand ( ) that you can use to
click and drag the view to pan it vertically and horizontally when you
are zoomed in. You can also pan using the scroll bars. Press the Esc
key to return to the Normal Selection tool.

Ctrl+M Marquee Zoom tool. This button turns the pointer into a marquee

zoom tool: . Use it to draw a box (called a marquee) on the view
and OMEGASCOPE™ will magnify that box to fill the view. Scroll bars
will appear, which you can drag to pan around in the view, or you
can pan by using the Hand tool (see above). Zooming in also opens
the Zoom Overview  window. Press the Esc key to return to the
Normal Selection tool.

If you point to the time axis, the pointer changes into the horizontal

marquee zoom tool ( ), which restricts zooming to the horizontal
axis. This lets you zoom in by an arbitrary amount without disturbing
the vertical zoom factor.

Ctrl+I Zoom-in tool. Turns the pointer into a zoom-in tool: . Click on
the view with this tool to zoom in to the specified location. Zooming
in also opens the Zoom Overview  window.

If you point to the time axis, the pointer changes into the horizontal

zoom-in tool ( ), which restricts zooming to the horizontal axis.
This lets you zoom in without disturbing the vertical zoom factor.

Ctrl+O Zoom-out tool. Turns the pointer into a zoom-out tool: . Click on
the view with this tool to zoom out around the specified location.

If you point to the time axis, the pointer changes into the horizontal

zoom-out tool ( ), which restricts zooming to the horizontal axis.
This lets you zoom out without disturbing the vertical zoom factor.

Undo zoom. Returns the view to the previous zoom and pan
settings.

Ctrl+U Zoom to full view. Resets the view to normal size. The view will no
longer have scroll bars, and panning will no longer be possible.
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7.8.1 Zoom Overview
Whenever you zoom in using the Zooming and Scrolling toolbar , the Zoom
Overview window should appear*:

The Zoom Overview shows the full waveforms
on all enabled channels. The rectangle indicates
the area that is visible in the current view.

You can move around the waveform by dragging
the rectangle.

You can also adjust the zoom factor by dragging
the edges of the rectangle to resize it.

Minimize button: reduce the Zoom Overview
window in size without affecting the zoom
settings.

Close button: close the Zoom Overview window
and return the zoom factor to 100%.

*Note: if the Zoom Overview does not appear, the feature may have been switched
off. Check the Zoom Overview option in Tools  > Preferences  > Options .
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8 How to...
This chapter explains how to perform some common tasks.

Change to a different scope device
Use rulers to measure a signal
Measure a time difference
Move a view
How to scale and offset a signal
How to set up the spectrum view
Find a glitch using persistence mode
Set up a Mask Limit Test
Save on trigger
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8.1 How to change to a different device
Unplug the old device
Plug in the new device

OMEGASCOPE™ detects that the device has changed and immediately starts using the
new one.

If more than one device is connected then you will see the Connect Device dialog
, which allows you to select a device to use.
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101



OMEGASCOPE™ User's Guide 137

 M5064

8.2 How to use rulers to measure a signal
Using a single ruler for signal-to-ground measurements

Look at the Channels toolbar  to find the color code for the channel  you wish
to measure:

Find the ruler handle (the small colored square in the top-left or top-right corner of
the scope view  or spectrum view ) of this color:

Drag the ruler handle downwards. A signal ruler  (horizontal broken line) will
appear across the view. Release the ruler handle when the ruler is where you want
it.

Look at the ruler legend  (the small table that appears on the view). It should
have a row marked by a small colored square matching the color of your ruler
handle. The first column shows the signal level of the ruler.

Using two rulers for differential measurements

Follow the steps above for "using a single ruler".
Drag the second ruler handle of the same color downwards until its ruler is at the
signal level to be measured.
Look at the ruler legend  again. The second column now shows the signal level of
the second ruler, and the third column shows the difference between the two rulers.
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8.3 How to measure a time difference
Find the time ruler handle (the small white square in the bottom left corner of the
scope view ).

Drag the ruler handle to the right. A time ruler  (vertical broken line) will appear
on the scope view. Release the ruler handle when the ruler is at the time you wish
to use as the reference.

Drag the second white ruler handle to the right until its ruler is at the time to be
measured.
Look at the ruler legend  (the small table that appears on the scope view). It
should have a row marked by a small white square. The first two columns show the
times of the two rulers, and the third column shows the time difference.

The frequency legend  shows 1/ , where  is the time difference.

You can use a similar method to measure a frequency difference on a spectrum view.

13

22

23

23

16



OMEGASCOPE™ User's Guide 139

 M5064

8.4 How to move a view
You can easily drag a view  from one viewport  to another. This example shows
four viewports, which contain scope views  called "Scope 1" to "Scope 4". Suppose
that you wish to move the "Scope 4" view to the top left viewport.

1. Click on the name tab of the "Scope 4" view
and hold the mouse button down.

2. Drag the mouse pointer to the new location
next to the name tab of the "Scope 1" view.

3. Release the mouse button, and the view will
move to the new location.

12 174
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8.5 How to scale and offset a signal
OMEGASCOPE™ offers two ways to change the size and position of a signal during or
after capture. These methods apply equally to scope views  and spectrum views .
They do not change the stored data, only the way in which it is displayed. These
options are provided in addition to the analog offset  capability of the OMSP-3000
Series scopes.

Global zooming and scrolling

This is usually the quickest way to get a closer look at the fine detail on your signals.
The global zooming and scrolling tools move all the signals at once and are found on
the zooming and scrolling toolbar.

When a view is zoomed in, it has vertical and horizontal scroll bars that let you move
the signals around as a group. You can also use the hand tool to scroll around the
graph.

Axis scaling and offset

Use these tools to position individual signals on the graph (unlike the global zooming
and scrolling tools, which are applied to all of the signals at the same time). Axis
scaling and offset tools are ideal when a signal on one channel is smaller than on
another or when you just want to make the best use of available screen space.
Common uses are: -

Aligning signals that have different amplitudes or offsets, for an overlay
comparison:
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Arranging the signals in their own rows for side-by-side comparison:

Click the scaling button  at the bottom of the axis you wish to modify, and the
axis scaling controls  will appear. To adjust the offset without using the axis scaling
controls, click on the vertical axis and drag it up or down.

How to use these tools together

These global and axis-specific tools work smoothly together and make it easy to move
around your data once you know how. We will take a look at a common example of
usage to explain how the tools can be used together.

Consider this common setup where all 4 channels are being displayed on the
centreline of the graph.

109
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Step 1. Arrange the signals into rows using the axis offset tool, so we can clearly
see them all side by side.

Step 2. Scale the signals so that they have roughly equal amplitudes. This
eliminates the overlap and makes the smaller signal easier to read.
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Step 3. Now we want to take a closer look at a specific time range of the signal in
greater detail. We don’t want to mess around with the neat axis scaling and offset
that we have spent time creating, so instead we use the global windowed-zoom
tool to select a specific section of the entire graph to zoom.

We can of course use the scrollbars or the hand tool to navigate around this zoomed
view without ever changing our carefully arranged signals. Clicking the Zoom 100%
button will take us back to the full view of our data; and again, this happens without
affecting our axis scaling and offset set-up.
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How is this different from scaling my data with a Custom Probe?

You can create a Custom Probe  to apply scaling to the raw data. A Custom Probe
may change the scale and position of data on the graph but it has a few important
differences from the other scaling methods.

Custom Probe scaling is a permanent transformation. The scaling is applied when
the data is captured and cannot be changed afterwards.
The actual data values themselves are changed so the graph axes may no longer
display the voltage range of the device.
Custom Probe scaling can be nonlinear and so may alter the shape of the signal.

Custom Probes are useful when you want to represent the characteristics of a physical
probe or transducer that you plug into your scope device. All of the zooming, scrolling,
scaling and offset tools still apply to data that has been scaled with a Custom Probe in
exactly the same way that they would apply to the raw data.

24
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8.6 How to set up the spectrum view
Creating a spectrum view

First, ensure that the trigger mode  is not set to ETS , as it is not possible to open
a spectrum view in ETS trigger mode.

There are three ways to open a spectrum view :

Click the Spectrum Mode button in the Capture Setup toolbar . We recommend
using this method to get the best spectrum analysis performance from your scope.
Once in Spectrum Mode, you can still open a scope view to see your data in the
time domain, but OMEGASCOPE™ optimizes the settings for the spectrum view.

Go to the Views menu  select Add view, then select Spectrum.

This method opens a spectrum view in the currently selected mode, whether this is
Scope Mode or Spectrum Mode. For best results, we recommend that you switch to
Spectrum Mode, as described in the method immediately above.

Right-click on any view , select Add view, then select Spectrum. The menu is
similar to the Views menu  shown above.

Configuring the spectrum view

See Spectrum Settings dialog .

Selecting the source data

OMEGASCOPE™ can produce a spectrum view  based on either live or stored data. If
OMEGASCOPE™ is running (the Start  button is pressed in), the spectrum view
represents live data. Otherwise, with OMEGASCOPE™ stopped (the Stop  button
pressed in), the view represents data stored in the currently selected page of the
waveform buffer. When OMEGASCOPE™ is stopped, you can use the buffer controls
to scroll through the buffer and the spectrum view will be recalculated from the
waveform currently selected.
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8.7 How to find a glitch using persistence mode
Persistence mode  helps you find rare events hidden in otherwise repetitive
waveforms. In normal scope mode, such an event may appear on the display for a
fraction of a second, too quickly for you to press the space bar to freeze it on the
screen. Persistence mode keeps the event on the display for a predetermined time,
allowing you to set up the trigger options to capture it more reliably.

Step-by-step guide

Set up the scope to trigger on a repetitive waveform like the one below. We suspect
that there are occasional glitches but we can see nothing wrong yet, so we shall
use persistence mode to investigate.
Click the Persistence Mode button  to continue.
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Our original scope view is replaced by a persistence view, as shown below.
Immediately, we can see three pulses with different shapes. At this point we have
the Saturation control in Persistence Options  turned up to maximum to help
us spot the various waveforms easily.

116
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Now that we have found some glitches, we will turn the Saturation control down
to minimum. Click the Persistence options button to open the Persistence
Options dialog , and then use the slider to adjust the saturation. The display
then appears as below.

The waveforms are now darker but have a wider range of colors and shades. The
most frequently occurring waveform is shown in red, and is the normal shape of the
pulse. A second waveform is drawn in light blue to shows that it occurs less
frequently, and it shows us that there is an occasional jitter of about 10 ns in the
pulse width. The third waveform is drawn in dark blue because it occurs less
frequently than the other two, and indicates that there is an occasional runt pulse
about 300 mV lower in amplitude than normal.

116
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Persistence mode has done its job. We have found our glitches, and now we want
to examine them in more detail. The best way to do this is to switch back to
normal scope mode , so that we can use the advanced triggering  and
automatic measurement  functions built in to OMEGASCOPE™.

Click the Scope Mode button. Set up an advanced pulse-width trigger to look for
a pulse wider than 60 ns. OMEGASCOPE™ then finds the runt pulse straight away.

We can now add automatic measurements or drag the rulers into place to analyse the
runt pulse in detail.
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8.8 How to set up a Mask Limit Test
For full information on this feature, see: Mask Limit Testing .

1. Display a stable waveform in a scope view . Adjust the voltage range and
timebase so that the feature of interest fills most of the view. In this example, we are
viewing a repetitive pulse as might be found on a data bus.

2. Select the Tools  > Masks  > Add Masks command.
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3. You should now be in the Mask Library dialog :

Channel A is selected by default. You can change this if you want to apply the mask
to a different channel.

4. Click the Generate button to open the Generate Mask dialog :
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5. For now, accept the default settings and click Generate. Then click OK in the Mask
Library dialog  to return to the scope view:

You now have a mask drawn around the original waveform.

6. OMEGASCOPE™ stops capturing when you enter the Mask Library dialog , so
press the space bar to restart. If any captured waveform fails to fit inside the mask,
the offending parts are drawn in a contrasting color. The Measurements table
shows the number of failures:

7. You now have a functioning mask limit test. Please read the Mask Limit Test
topic for information on editing, importing and exporting masks. It is also possible to
set up a Mask Limit Test on a spectrum  or XY  view.
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8.9 How to save on trigger
Save-on-trigger is just one of a number of functions that are possible with the
Alarms  feature.

1. Set up OMEGASCOPE™ to display your waveform, and enable triggering:

2. Select the Tools  > Alarms  command:

83
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3. You should now be in the Alarms dialog :

4. Set Event to Capture:

83
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5. Select the first item in the Actions list, click Edit, and change Action to Save
Current Buffer:

6. Click the  button to the right of the File box and enter the name and location of
the file to save:
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7. Ensure that both the Save Current Buffer check box and the Enable Alarm check
box are set:

8. Click OK. OMEGASCOPE™ will now save a file on every trigger event.

9. Switch off the alarm when you have finished using it, to avoid creating unwanted
files.
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9 Reference
This is where you can find detailed information on the operation of OMEGASCOPE™.

Measurement types
Spectrum window functions
Serial protocols
Trigger timing
Command-line syntax
Glossary

9.1 Measurement types
The Edit Measurement dialog  allows you to select one of a range of measurements
that OMEGASCOPE™ can calculate for the selected view. The list of measurements
available depends on whether the view is a scope view  (see scope measurements

) or a spectrum view  (see spectrum measurements ).

157

162

165

163

171

173

44

13

158 16 159



Reference158

 M5064

9.1.1 Scope measurements
AC RMS. The root mean square (RMS) value of the waveform minus the DC Average.
It is equivalent to a ripple measurement.

Cycle Time. OMEGASCOPE™ will attempt to find a repeated pattern in the waveform
and measure the duration of one cycle.

DC Average. The mean value of the waveform.

Duty Cycle. The amount of time that a signal spends above its mean value,
expressed as a percentage of the signal period. A duty cycle of 50% means that the
high time is equal to the low time.

Falling Rate. The rate at which the signal level falls, in signal units per second. Click
the Advanced button in the Add Measurement or Edit Measurement dialog to
specify the signal level thresholds for the measurement.

Frequency. The number of cycles of the waveform per second.

Fall Time. The time the signal takes to fall from the upper threshold to the lower
threshold. Click the Advanced button in the Add Measurement or Edit
Measurement dialog to specify the signal level thresholds for the measurement.

High Pulse Width. The amount of time that the signal spends above its mean value.

Low Pulse Width. The amount of time that the signal spends below its mean value.

Maximum. The highest level reached by the signal.

Minimum. The lowest level reached by the signal.

Peak To Peak. The difference between maximum and minimum.

Rise Time. The time the signal takes to rise from the lower threshold to the upper
threshold. Click the Advanced button in the Add Measurement or Edit
Measurement dialog to specify the signal level thresholds for the measurement.

Rising Rate. The rate at which the signal level rises, in signal units per second. Click
the Advanced button in the Add Measurement or Edit Measurement dialog to
specify the signal level thresholds for the measurement.

True RMS. The root mean square (RMS) value of the waveform, including the DC
component.

Mask Failures. A special measurement that counts the number of failed waveforms
in Mask Limit Testing  mode. This measurement is added to the table automatically
when you use Mask Limit Testing, so there is usually no need to select it manually.

28
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9.1.2 Spectrum measurements
To add a spectrum measurement, open a spectrum view  and then click the Add
Measurement  button. You can use these measurements in either scope mode  or
spectrum mode .

Frequency at peak. The frequency at which the peak signal value appears.

Amplitude at peak. The amplitude of the peak signal value.

Average amplitude at peak. The amplitude of the peak signal value averaged over a
number of captures.

Total power. The power of the whole signal captured in the spectrum view,
calculated by adding the powers in all of the spectrum bins.

Total Harmonic Distortion (THD). The ratio of the sum of harmonic powers to the
power at the fundamental frequency.

Total Harmonic Distortion plus Noise (THD+N). The ratio of the harmonic power
plus noise to the fundamental power. THD+N values are always greater than the THD
values for the same signal.

Spurious-free Dynamic Range (SFDR). This is the ratio of the amplitude of the
specified point (normally the peak frequency component) and the frequency
component with the second largest amplitude (call it "SFDR frequency"). The
component at the "SFDR frequency" is not necessarily a harmonic of the fundamental
frequency component. For example, it might be a strong, independent noise signal.

Signal+Noise+Distortion to Signal+Noise Ratio (SINAD). The ratio, in decibels,
of the signal-plus-noise-plus-distortion to noise-plus-distortion.

Signal to Noise Ratio (SNR). The ratio, in decibels, of the mean signal power to the
mean noise power. Hanning or Blackman windows are recommended because of their
low noise.
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Intermodulation Distortion (IMD). A measure of the distortion caused by the
nonlinear mixing of two tones. When multiple signals are injected into a device,
modulation or nonlinear mixing of these two signals can occur. For input signals at
frequencies f1 and f2, the two second-order distortion signals will be found at
frequencies: f3 = (f1 + f2) and f4 = (f1 - f2).

IMD is expressed as the dB ratio of the RMS sum of the distortion terms to the RMS
sum of the two input tones. IMD can be measured for distortion terms of any order,
but the second-order terms are most commonly used. In the second-order case, the
intermodulation distortion is given by:

where

F3 and F4 are the amplitudes of the two second-order distortion terms (at
frequencies f3 and f4 defined above)

and

F1 and F2 are the amplitudes of the input tones (at frequencies f1 and f2, as
marked by the frequency rulers in the spectrum window).

For reference, the third-order terms are at frequencies (2F1 + F2), (2F1 - F2), (F1 +
2F2) and (F1 - 2F2).

Note: Hanning or Blackman windows are recommended because of their low noise. An
FFT size of 4096 or greater is recommended in order to provide adequate spectral
resolution for the IMD measurements.

Mask Failures. See Mask Limit Testing .28
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9.2 Signal generator waveform types
The list of waveform types available in the Signal Generator dialog  varies
according to the type of oscilloscope connected. The full list is as follows:

Sine Sinusoid

Square Square wave

Triangle Symmetrical triangle wave

RampUp Rising sawtooth

RampDown Falling sawtooth

Sinc sin(x)/x, truncated on the x axis

Gaussian The 'bell curve' of the normal distribution,
truncated on the x axis

HalfSine The positive half of a sinusoid

WhiteNoise Random samples with the maximum possible
bandwidth

PRBS Pseudo-random binary sequence. A random
sequence of bits.

DCVoltage Constant voltage, adjustable using the Offset
control.

Arbitrary As defined by the arbitrary waveform editor.
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9.3 Spectrum window functions
To create a spectrum view , OMEGASCOPE™ captures a block of sampled data over
a finite time interval and then uses a Fast Fourier Transform to compute its spectrum.
The algorithm assumes a signal level of zero at all times outside the captured time
interval. Typically, this assumption causes sharp transitions to zero at either end of
the data, and these transitions have an effect on the computed spectrum, creating
unwanted artefacts such as ripple and gain errors. To reduce these artefacts, the
signal can be faded in and out at the start and end of the block. There are several
commonly used "window functions" that can be convolved with the data to effect this
fading, and which are chosen according to the type of signal and the purpose of the
measurement.

The Window Functions control in the Spectrum Options dialog  lets you select
one of the standard window functions for spectrum analysis. The following table shows
some of the figures of merit used to compare the functions.

Window Main peak
width (bins
@ -3 dB)

Highest 
side lobe
(dB)

Side lobe 
roll-off
(dB/octave)

Notes

Blackman 1.68 -58 18 often used for audio work

Gaussian 1.33 to 1.79 -42 to -69 6 gives minimal time and
frequency errors

Triangular 1.28 -27 12 also called Bartlett window

Hamming 1.30 -41.9 6 also called raised sine-squared;
used in speech analysis

Hann 1.20 to 1.86 -23 to -47 12 to 30 also called sine-squared; used
for audio & vibration

Blackman-Harris 1.90 -92 6 general-purpose

Flat-top 2.94 -44 6 negligible pass-band ripple;
used mainly for calibration

Rectangular 0.89 -13.2 6 no fading; maximal sharpness;
used for short transients

16
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9.4 Trigger timing (part 1)
The pre-trigger time control and post-trigger delay control functions are
described individually under "Triggering toolbar" , but the interaction between the
two controls is also important to understand. Here is a screen shot of a scope view
with post-trigger delay enabled:

Note 1. The trigger reference point ( ) does not lie on the waveform. This is because
the post-trigger delay is set to 200 µs, which means that the trigger occurred
200 µs before the reference point, somewhere off the left-hand edge of the
scope view.  The time axis is aligned so that the trigger reference point is
at 200 µs.

Note 2. The pre-trigger delay is set to 25%, which makes the trigger reference point
appear 25% of the way across the scope view from the left-hand edge.

Note 3. OMEGASCOPE™ limits the trigger-to-reference-point delay to a multiple of the
total capture time. Once you have reached this limit, the program will not let
you increase the pre-trigger delay, and if you increase the post-trigger delay,
OMEGASCOPE™ will reduce the pre-trigger delay to stop the total exceeding
the limit. The multiple is typically 100 in most trigger modes, and 1 in ETS
mode.

127
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9.5 Trigger timing (part 2)
"Trigger timing (part 1) " introduced the concepts of pre-trigger delay  and the
post-trigger delay . This diagram below shows how they are related.

The pre-trigger delay positions the scope view  in relation to the trigger reference
point so that you can choose how much of the waveform should be before the
reference point, and how much after it.

The post-trigger delay is like the delayed trigger of a conventional oscilloscope.
OMEGASCOPE™ waits for this time after the trigger event before drawing the trigger
reference point. Scope devices have a limit to the number of sampling intervals that
can elapse between the trigger event and the end of the capture, so the software may
adjust the pre-trigger delay to keep within this limit.

Tip: If you have set up a post-trigger delay, you can click the post-trigger delay
button while the scope is running whenever you want to switch between viewing the
trigger event and the trigger reference point.

163 127
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9.6 Serial protocols
The serial decoding  function can decode the following serial protocols:

CAN Bus
I2C Bus
RS-232 (UART)
SPI Bus

27
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9.6.1 CAN Bus protocol
You can decode CAN Bus data using the serial decoding  feature built into
OMEGASCOPE™. 

About CAN Bus

CAN (Controller Area Network) Bus is a serial protocol used in automotive and
industrial machinery to allow microcontrollers to communicate with each other. The
standard was originally developed in 1983 by Robert Bosch GmbH. It typically uses
differential signalling (with signals named CAN H and CAN L) to increase noise
immunity. OMEGASCOPE™ supports CAN Bus bit rates from 10 kbit/s to 1 Mbit/s.

The in-window view of the data looks like this:

The columns in the data table are as follows:

Column Description
No. Serial number of the frame (decimal). If Accumulate mode is off,

this counts from the start of the selected waveform. If Accumulate
mode is on, this counts from the start of the first waveform in the
waveform buffer.

ID Identifier (hexadecimal). Should be unique for a specified data
type. Base frames have an 11-bit identifier, and extended frames
have a 29-bit identifier.

Frame CAN Bus data is divided into frames, each consisting of a number
of bits. A frame can be any of the following types:

Data: contains data destined for a node
Remote: a request for the transmission of a specific identifier
Error: transmitted by a node that detects an error
Overload: inserted to add a delay between frames
Interframe: time interval preceding data frames and remote
frames

Any frame can also be a base frame or an extended frame.

RTR Remote transmission request

SRR Used only in extended frames

IDE Identifier extension bit

R0 Reserved bit

27
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R1 Reserved bit, extended frames only

DLC Data length code.  Indicates the number of bytes of data.

Data bytes The data content of the message, DLC bytes long (hexadecimal)

CRC Sequence A cyclic redundancy check of the data (hexadecimal)

CRC Delimiter A fixed bit following the CRC Sequence field

Ack Slot Node asserts this bit to acknowledge receipt

Ack Delimiter A fixed bit following the Ack Slot field

Error Set if OMEGASCOPE™ detects an error

Start Time Value of OMEGASCOPE™ timebase at start of frame

End Time Value of OMEGASCOPE™ timebase at end of frame
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9.6.2 I²C Bus protocol
You can decode I2C Bus data using the serial decoding  feature built into
OMEGASCOPE™. 

About I2C Bus

I2C (Inter-Integrated Circuit) Bus is a serial protocol used mainly in consumer
electronics for communications between devices on the same circuit board, and
between computers and displays. The standard was originally developed in the 1980s
by Philips. It uses two signals: clock (SCL) and data (SDA). Speeds up to 3.4 Mbit/s
are possible.

The in-window view of the data looks like this:

The columns in the data table are as follows:

Column Description
No. Serial number of the packet (decimal). If Accumulate mode is

off, this counts from the start of the selected waveform. If 
Accumulate mode is on, this counts from the start of the first
waveform in the waveform buffer.

Packet Packet type: Start, Stop, Address, Data or Unknown.

Address Shown for address packets.

Read/Write Polarity of the Read/Write flag.

Data bytes Contents of data packets.

Acknowledge Whether the destination acknowledged the packet.

Baud Rate The signalling rate detected for this packet.

Start Time Time according to OMEGASCOPE™ timebase at start of frame.

End Time Time according to OMEGASCOPE™ timebase at end of frame.
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9.6.3 RS232/UART protocol
You can decode RS232 (UART) data using the serial decoding  feature built into
OMEGASCOPE™. 

About RS232

RS232 is the serial data standard used by UARTs (Universal Asynchronous Receiver/
Transmitters) in the "serial" or "COM" ports once commonly found on computers. It
was developed in the 1960s for connecting modems to terminals. The full standard
uses a voltage swing of ±12 V, larger than most other standards. Data rates of 115
kbit/s are possible. The simplest RS232 connection consists of two signals: Rx
(receive) and Tx (transmit).

The in-window view of the data looks like this:

The columns in the data table are as follows:

Column Description
No. Serial number of the packet (decimal). If Accumulate mode is

off, this counts from the start of the selected waveform. If 
Accumulate mode is on, this counts from the start of the first
waveform in the waveform buffer.

Packet Packet type: all packets in this format are classified as Data.

Start Bit If present, this is the fixed "1" bit at the start of the word.

Data bytes Contents of data packets.

Parity Bit The error-correction bit, if present, at the end of the word.

Stop Bit If present, this is the fixed "1" bit at the end of the word.

Error Indicates whether there was a data error.

Start Time Time according to OMEGASCOPE™ timebase at start of frame.

End Time Time according to OMEGASCOPE™ timebase at end of frame.
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9.6.4 SPI Bus protocol
You can decode SPI Bus data using the serial decoding  feature built into
OMEGASCOPE™. 

About SPI Bus

SPI (Serial Peripheral Interface) Bus is a serial data standard used for communication
between microprocessors and peripheral devices. It was developed by Motorola. The
original standard uses a 4-wire link, although 3-wire and 2-wire versions are also
used.

The in-window view of the data looks like this:

The columns in the data table are as follows:

Column Description
No. Serial number of the packet (decimal). If Accumulate mode is

off, this counts from the start of the selected waveform. If 
Accumulate mode is on, this counts from the start of the first
waveform in the waveform buffer.

Packet Packet type: Start, Stop, Address, Data or Unknown.

Data bytes Contents of data packets.

Start Time Time according to OMEGASCOPE™ timebase at start of frame.

End Time Time according to OMEGASCOPE™ timebase at end of frame.
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9.7 Command-line syntax
To display the GUI

OMEGASCOPE <filename>

<filename> Specifies a single .psdata or .pssettings file.

Example: OMEGASCOPE C:\Temp\source.psdata

To display help

OMEGASCOPE /?

Shows help on all command line options.

To convert psdata files

OMEGASCOPE /C,/c 

Converts a psdata file from one format to another. Cannot be used with /p[rint].

Syntax:

OMEGASCOPE /c[onvert] <names> [/d <names>] /f <format> [/q] 
[/b [<n>[:<m>]] | [all]] [/v <viewportname>]

<names> Specifies a list of one or more directories or psdata files.
Wildcards may be used to specify multiple files. If a
directory is specified, all psdata files within that
directory will be specified. This is a mandatory
argument.

/d <names> Destination. Default is input filename with new
extension.

/f <format> Destination format: csv, txt, png, bmp, gif, a[nimated]
gif, psdata, pssettings, matlab. This is a mandatory
argument.

/q Quiet mode. Do not ask before overwriting files. The
default is to prompt.

/b [<n>[:<m>]]|all Waveform number n, waveform range n to m or all
waveforms. The default is the current waveform.

/v <viewportname> View to convert. Default is current view.

Example: 

OMEGASCOPE /c C:\Temp\source.psdata /f png /b 5:9 /v Scope2
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To print a view

OMEGASCOPE /P,/p

Prints a view in the psdata file. Cannot be used with /c[onvert].

Syntax:

OMEGASCOPE /p[rint] <names> [/b [<n>[:<m>]] | all] [/v <viewportname>]

<names> Specifies a list of one or more directories or .psdata files. Wildcards
may be used to specify multiple files. If a directory is specified, all
.psdata files within that directory will be specified. This is a
mandatory argument.

/b [<n>[:

<m>]]|all 
Waveform number n, waveform range n to m or all buffers. Default
is current waveform.

/v
<viewportname

> 

View to convert. Default is current view.

Example: 

OMEGASCOPE /p C:\Temp\source.psdata /b 5:9 /v Scope2
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9.8 Glossary
AC coupling. In this mode, the scope device rejects very low signal frequencies below
about 1 hertz. This allows you to use the full resolution of the scope to measure a.c.
signals accurately, ignoring any d.c. offset. You cannot measure the signal level with
respect to ground in this mode.

AWG. An arbitrary waveform generator (AWG) is a circuit that can generate a
waveform of almost any shape. It is programmed with a data file, supplied by the
user, which defines the output voltage at a number of equally spaced points in time.
The circuit uses this data to reconstruct the waveform with a specified amplitude and
frequency.

Axis. A line marked with measurements. OMEGASCOPE™ shows one vertical axis for
each channel that is enabled in a view, giving measurements in volts or other units.
Each view also has a single horizontal axis, which is marked in units of time for a
scope view, or units of frequency for a spectrum view.

Channel. A scope device has one or more channels, each of which can sample one
signal. High-speed scope devices typically have one BNC connector per channel.

CSV. Comma-separated values. A form of text file containing a list of values separated
by commas and line-breaks. CSV format is used for importing and exporting
OMEGASCOPE™ arbitrary waveform files . You can also export OMEGASCOPE™
waveforms in CSV format. CSV files can be imported into spreadsheets and other
programs.

DC coupling. In this mode, the scope device measures the signal level relative to
signal ground. This shows both d.c. and a.c. components.

Dead time. The time between the end of one capture and the start of the next. To
obtain the minimum possible dead time, use Rapid trigger mode.

Demo mode. If OMEGASCOPE™ is started when no scope device is plugged in, it
allows you to select a "demo device", a virtual scope unit that you can use to test the
software. The program is then in "demo" (short for "demonstration") mode. This mode
provides a simulated, configurable signal source for each input channel of the demo
device.

ETS. Equivalent Time Sampling. A method of increasing the effective sampling rate of
the scope. In a scope view, the program captures several cycles of a repetitive signal,
then combines the results to produce a single waveform with higher time-resolution
than a single capture. For accurate results, the signal must be perfectly repetitive and
the trigger must be stable.

Graticule. The horizontal and vertical dashed lines in every view. These help you
estimate the amplitude and time or frequency of features on the waveform.

Grid. The arrangement of viewports. The number of grid rows and the number of grid
columns can each be either 1, 2, 3 or 4.

In focus. OMEGASCOPE™ can display several views, but only one view is in focus at
any time. When you click a toolbar button, it will usually affect only the view that is in
focus. To bring a view into focus, click on it.
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PC Oscilloscope. A measuring instrument consisting of a scope device  and the
OMEGASCOPE™ software running on a PC. A PC Oscilloscope has the same functions
as a traditional bench-top oscilloscope but is more flexible and cost-effective. You can
improve its performance by upgrading the PC using standard parts from any computer
shop, or by purchasing a new scope device, and you can upgrade the software by
downloading an update from Omega Engineering, Inc.

Probe. An accessory that attaches to your oscilloscope and picks up a signal to be
measured. Probes are available to pick up any form of signal, but they always deliver
a voltage signal to the oscilloscope. OMEGASCOPE™ has built-in definitions of
standard probes, but also allows you to define custom probes.

Progressive mode. Normally, OMEGASCOPE™ redraws the waveform in a scope view
many times every second. At timebases slower than 200 ms/div, however, it switches
to progressive mode. In this mode, OMEGASCOPE™ updates the scope view
continuously as each capture progresses, rather than waiting for a complete capture
before updating the view.

Resolution enhancement. Collecting samples at a faster rate than requested, then
combining the excess samples by averaging. This technique can increase the effective
resolution of a scope device when there is a small amount of noise on the signal. 
(More details.)

Ruler. A vertical or horizontal dashed line that can be dragged into place on a
waveform in a view. OMEGASCOPE™ displays the signal level, time value or frequency
value of all rulers in the Ruler Legend box.

Scope device. The oscilloscope that you plug into the USB or parallel port of your
computer. With the help of the OMEGASCOPE™ software, the scope device turns your
computer into a PC Oscilloscope.

Standard deviation. A statistical measure of the spread of a set of samples. The
standard deviation of the set  is defined as:

,

where is the arithmetic mean of all the samples. The units of the standard
deviation value are the same as those of the original samples.

Tool tip. A label that appears when you move the mouse pointer over some parts of
the OMEGASCOPE™ screen, such as buttons, controls and rulers.

Trigger. The part of an oscilloscope that monitors an incoming signal and decides
when to begin a capture. Depending on the trigger condition that you set, the scope
may trigger when the signal crosses a threshold, or may wait until a more complex
condition is satisfied.

Vertical resolution. The number of bits that the scope device uses to represent the
signal level. This number is fixed by the design of the device, but a greater effective
number can be obtained in some cases by using resolution enhancement .

View. A presentation of data from a scope device. A view may be a scope view ,
an XY view  or a spectrum view .

Viewport. The views in the OMEGASCOPE™ window  are arranged in a grid,  and
each rectangular area in the grid is called a viewport.
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10 Application Error dialog
If there is a problem with OMEGASCOPE™ and the program needs to close, the 
Application Error dialog appears:

It would be very helpful to us if you could send us a report of the problem. All you
need to do is click the Send Report button, then save the .zip file in a place where

you can easily find it again, such as on your desktop. Then, email the ..zip file to us

at das@omega.com, and we will do the rest. Don't worry if you can't think of a
comment to enter in the text box: just leave it empty and send the report to us
anyway.

mailto:das@omega.com
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Index

%
%buffer% variable    83

%file% variable    83

%time% variable    83

.
.bmp files, saving    33

.csv files, saving    33

.gif files, saving    33

.mask files    85

.png files, saving    33

.psdata files    

converting    102, 171

saving    33

.psmaths files    63, 67, 70

.psreference files    73

.pssettings files, saving    33

.txt files, saving    33

A
AC coupling    173

AC power    91

Accelerometer inputs    106

Add Measurement dialog    44

Adding a measurement    44

Address of company    3

Advanced measurement settings    45

Advanced triggering    127, 129

types    130

Alarms    29, 83

Save on trigger    153

Analog intensity    116

Analog offset    107

Animated GIF    33

Arbitrary waveform generator    119

editing window    122

files    121

importing from channel    124

Average (statistics)    18

AWG    173

Axis    13, 14, 16, 173

auto-arrange    40

horizontal    13, 14, 16

offset    140

scaling    140

scaling controls    109

vertical    13, 14, 16

B
Bandwidth limiter    107

Battery power    91

Beep    83

Binary files, exporting    36

Bit Definitions dialog    80

Bit stream    122

Buffer Navigation toolbar    105

Buffer Navigator    30

C
CAN Bus protocol    166

Capture count    18

Capture modes    10, 11

Capture rate preference    91

Capture Setup toolbar    112

Capture size preference    90

Channel    173

selecting in a view    40

Channel Options    

button    106

menu    107

Channel settings    

in Properties sheet    24

Channel Setup toolbar    

standard    106

Channel warning symbol    25

Clipboard    38

Close file    32

Collection time units    90

Color preferences    97

Column auto-width    43

Command line syntax    171

Connect Device dialog    32, 101

Contact information    3

Converter, how to change    136

Converting data files    102, 171

Copy    

as image    38

as text    38

Coupling control    106

Create New Custom Probe dialog    50

CSV files, exporting    35

Cursors (see Rulers)    21, 22, 23

Custom grid layout dialog    42

Custom Probe Manager    47

Custom Probe wizard    50

Create New Custom Probe dialog    50
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Custom Probe wizard    50

Edit Existing Custom Probe dialog    51

Edit Range dialog    57

Edit Range dialog (Advanced tab)    59

Finished dialog    62

Lookup-table Scaling dialog    54

Manual Ranges Setup dialog    56

Probe ID dialog    61

Probe Output Units dialog    52

Range Management dialog    55

Scaling Method dialog    53

Custom probes    24

dialog    48

saving    32

D
Data files    

converting    102

DC coupling    173

Dead time    173

Decoding tab    27

Default Print Settings    96

Demo device    125

Demo mode    125, 173

Demo Signals    

dialog    125

toolbar    125

Digital color    116

Dropout trigger    130

E
Edge trigger    130

Edit Existing Custom Probe dialog    51

Edit menu    38

Edit Range dialog    57

Edit Range dialog (Advanced tab)    59

Edit Reference Waveform dialog    74

Effective resolution    19

Email addresses    3

Equation dialog    67

Equivalent-time sampling    127

ETS    127, 173

and Advanced Triggering    129

Exit    32

Exporting data    35

binary format    36

text format    35

F
Fall time    

threshold    45

Falling edge button    127

Fax number    3

File conversion    102

File menu    32

Filter Method dialog    60

Filtering    107

channels    110

measurements    18

statistics    45

Focus    173

Frequency counter    106

Frequency difference, measuring    138

Frequency legend    22, 23

Frequency rulers    22

Functions, mathematical    67

G
General preferences    90

Generate mask    85

Generate Mask dialog    87

Glitches, finding    130

Glossary    173

Graticule    13, 14, 16, 173

Grid    173

layout    40, 42

H
Hand tool    133

Harmonic control for measurements    45

Help menu    100

Horizontal axis    13, 14, 16

House current    91

Hysteresis    132

I
I²C Bus protocol    168

I2C settings    82

I2C Settings dialog    82

Image, saving as    33

Import from a Channel dialog    124

Input impedance    106

Interpolation    

linear    92

sin(x)/x    92

Interval trigger    129, 130

Introduction    3

Invert button    25
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K
Keyboard shortcuts    94, 133

L
Language preferences    95

Line thicknesses    97

Lissajous figures    14

Logic trigger    130

Lookup-Table Scaling dialog    54

Lowpass filtering    60, 107, 110

M
Macro Recorder    88

Mains power    91

Manual Ranges Setup dialog    56

Marquee Zoom tool    133

Mask Limit Testing    28, 47

How To    150

Masks    

colors    28, 97

displaying    40

editing    86

export    85

generate    85

import    85

in Buffer Navigator    30

library dialog    85

menu    85

polygons    86

selection dialog    28

Math channels    47

button    106

saving    32

Maths Channel Wizard    

Equation dialog    67

Finished dialog    72

Introduction dialog    66

Name and Color dialog    70

overview    65

Units and Range dialog    71

Maths channels    63

Built In    63

dialog    63

Library    63

Loaded    63

overview    25

Matlab 4 files    

exporting    36, 73

Max (statistics)    18

Maximum Waveforms preference    90

Measurement statistics    

capture size    90

Measurement system    

selecting    95

Measurements    

adding    18, 43, 44

advanced settings    45

deleting    18, 43

editing    18, 43

filtering    18

font size    43

list of types    157

menu    43

scope    158

spectrum    159

statistics    18

table    18

toolbar    118

Menus    31

Metric measurements    95

Min (statistics)    18

Missing events, finding    130

N
Normal Selection tool    133

Notes area    38, 39

O
Offset    140

analog    107

OMEGASCOPE™    1, 2, 9

how to use    3, 6, 7

main window    12

Open file    32

Oscilloscope    7

Overrange indicator    13, 106

P
Page Down key    32

Page Up key    32

Panning    134

PC Oscilloscope    8

Persistence mode    17

button    112

enabling and disabling    99

options    116

Pointer tool tip    20

Polygon    86

Post-trigger delay    163
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Post-trigger delay    163

arrow    15

control    127, 163

Power Management preferences    91

Preferences    47

capture rate    91

colours    97

Default Print Settings    96

device selection    99

dialog    89

general    90

keyboard    94

language    95

persistence modes    99

power management    91

sampling    92

spectrum modes    99

Pre-trigger delay    163

control    127, 163

Printing    32

from command line    171

from menu    32

preferences    96

preview    32

Probe    173

custom    24

Probe ID dialog    61

Probe Output Units dialog    52

Progress bar    114

Progressive mode    173

Properties sheet    24

displaying    40

Pulse width trigger    129, 130

R
Range control    106

Range Management dialog    55

Rapid trigger mode    127

Reference manual    100

Reference waveforms    47

adding    40

delay    109

dialog    73

Library    73

Loaded    73

overview    26

using in equations    67

Reset 'Don't show this again' dialogs    90

Resolution enhancement    19, 107, 173

Revolutions per minute    23

Rise time    

threshold    45

Rising edge button    127

RPM    23, 99

RS232    

protocol    169

settings    80

Rulers    13, 14, 16

definition    173

deleting    21, 22

handles    13, 14, 16

legend    23

lock button    23

time    13, 16

voltage    13, 14, 16

Runt pulse trigger    130

S
Sampling preferences    92

Sampling rate    112

Save As    32

dialog    33

Save file    32

Save on trigger    83, 153

Scaling    9, 140

button    109

Scaling Method dialog    53

Scope device    173

Scope measurements    

AC volts    158

Cycle time    158

DC volts    158

Duty cycle    158

Fall time    158

Falling rate    158

Frequency    158

High pulse width    158

Low pulse width    158

Maximum    158

Minimum    158

Peak to peak    158

Rise time    158

Rising rate    158

Scope mode    10

button    112

Scope view    11, 13

Scrolling    140

Selection tool, normal    133

Serial decoding    27, 47

data window    78

dialog    75

protocols    165
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Serial number    

of oscilloscope    100

Settings    

saving    32

Settings dialog    81

Signal difference, how to measure    137

Signal generator    

button    119

dialog    119

Waveform types    161

Signal rulers    13, 14, 16, 21

Sinx(x)/x preferences    92

Slow sampling transition    92

Smoothing    92

Software version    1

Sound file    83

Space bar    126

Spectrum measurements    

Amplitude at peak    159

Frequency at peak    159

Intermodulation Distortion (IMD)    159

Signal to Noise Ratio (SNR)    159

Spurious-free Dynamic Range (SFDR)    159

Total Harmonic Distortion (THD)    159

Total Harmonic Distortion plus Noise (THD+N)  
 159

Total power    159

Spectrum mode    10

button    112

enabling and disabling    99

Spectrum options    

bins    114

dialog    114

display mode    114

scale    114

Spectrum view    11, 16

how to set up    145

SPI Bus protocol    170

SPI settings    81

Spreadsheet, exporting to    33

Spurious edges, finding    130

Standard deviation    18, 173

Start/Stop toolbar    126

Startup Settings menu    38

Statistics    18

filtering    45

Symbols    

red warning    13

yellow warning    25

System requirements    5

T
Telephone number    3

Text files, exporting    33, 35

Threshold for measurements    45

Time difference, how to measure    138

Time gate    24

Time rulers    13, 16, 22

Timebase controls    112

Tool tip    173

Toolbars    104

Tools menu    47

Trace    7

Tracking rulers    23

Trademarks    3

Trigger    127, 163, 173

advanced    127, 129

dropout    130

dual-edge    129

edge    130

glitches    130

interval    129, 130

logic    130

marker    15

missing events    130

mode control    127

pulse width    129, 130

reference point    163

runt pulse    130

timing    163

toolbar    127

window    130

U
U.S. measurements    95

UART    

protocol    169

settings    80

Undo zoom    133

V
Valid edges, finding    130

Version    1

Version number    

hardware    100

software    100

Vertical axis    13, 14, 16

Vertical resolution    173

View    173

how to move    139
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View    173

menu    40

scope    13

selecting channels    40

spectrum    16

XY    14

Viewport    173

W
Warning symbol    106

red    13

yellow    25

Waveform    7, 13

saving    32

Waveform buffers    

number of    90

Window functions    114, 162

Window trigger    130

X
X axis, configuring    40

X-Axis command    14

XY view    14

Z
Zooming    140

undo    133

Zoom overview    134

Zooming and Scrolling toolbar    133
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WARRANTY/DISCLAIMER
OMEGA ENGINEERING, INC. warrants this unit to be free of defects in materials and workmanship for a
period of 13 months from date of purchase. OMEGA’s WARRANTY adds an additional one (1) month
grace period to the normal one (1) year product warranty to cover handling and shipping time. This
ensures that OMEGA’s customers receive maximum coverage on each product. 
If the unit malfunctions, it must be returned to the factory for evaluation. OMEGA’s Customer Service
Department will issue an Authorized Return (AR) number immediately upon phone or written request.
Upon examination by OMEGA, if the unit is found to be defective, it will be repaired or replaced at no
charge. OMEGA’s WARRANTY does not apply to defects resulting from any action of the purchaser,
including but not limited to mishandling, improper interfacing, operation outside of design limits, 
improper repair, or unauthorized modification. This WARRANTY is VOID if the unit shows evidence of 
having been tampered with or shows evidence of having been damaged as a result of excessive corrosion;
or current, heat, moisture or vibration; improper specification; misapplication; misuse or other operating
conditions outside of OMEGA’s control. Components in which wear is not warranted, include but are not 
limited to contact points, fuses, and triacs.
OMEGA is pleased to offer suggestions on the use of its various products. However, 
OMEGA neither assumes responsibility for any omissions or errors nor assumes liability for any
damages that result from the use of its products in accordance with information provided by
OMEGA, either verbal or written. OMEGA warrants only that the parts manufactured by it will be
as specified and free of defects. OMEGA MAKES NO OTHER WARRANTIES OR 
REPRESENTATIONS OF ANY KIND WHATSOEVER, EXPRESS OR IMPLIED, EXCEPT THAT OF TITLE,
AND ALL IMPLIED WARRANTIES INCLUDING ANY WARRANTY OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED. LIMITATION OF 
LIABILITY: The remedies of purchaser set forth herein are exclusive, and the total liability of 
OMEGA with respect to this order, whether based on contract, warranty, negligence, 
indemnification, strict liability or otherwise, shall not exceed the purchase price of the 
component upon which liability is based. In no event shall OMEGA be liable for 
consequential, incidental or special damages.
CONDITIONS:  Equipment sold by OMEGA is not intended to be used, nor shall it be used: (1) as a “Basic
Component” under 10 CFR 21 (NRC), used in or with any nuclear installation or activity; or (2) in medical
applications or used on humans. Should any Product(s) be used in or with any nuclear installation or
activity, medical application, used on humans, or misused in any way, OMEGA assumes no responsibility
as set forth in our basic WARRANTY/ DISCLAIMER language, and, additionally, purchaser will indemnify
OMEGA and hold OMEGA harmless from any liability or damage whatsoever arising out of the use of the
Product(s) in such a manner.

RETURN REQUESTS/INQUIRIES
Direct all warranty and repair requests/inquiries to the OMEGA Customer Service Department. BEFORE
RETURNING ANY PRODUCT(S) TO OMEGA, PURCHASER MUST OBTAIN AN AUTHORIZED RETURN
(AR) NUMBER FROM OMEGA’S CUSTOMER SERVICE DEPARTMENT (IN ORDER TO AVOID
PROCESSING DELAYS). The assigned AR number should then be marked on the outside of the return
package and on any correspondence.
The purchaser is responsible for shipping charges, freight, insurance and proper packaging to prevent
breakage in transit. 

FOR WARRANTY RETURNS, please have the 
following information available BEFORE 
contacting OMEGA:
1. Purchase Order number under which the product

was PURCHASED,
2. Model and serial number of the product under

warranty, and
3. Repair instructions and/or specific problems 

relative to the product.

FOR NON-WARRANTY REPAIRS, consult OMEGA
for current repair charges. Have the following
information available BEFORE contacting OMEGA:
1. Purchase Order number to cover the COST 

of the repair,
2. Model and serial number of the product, and
3. Repair instructions and/or specific problems 

relative to the product.

OMEGA’s policy is to make running changes, not model changes, whenever an improvement is possible. This affords
our customers the latest in technology and engineering.
OMEGA is a registered trademark of OMEGA ENGINEERING, INC.
© Copyright 2011 OMEGA ENGINEERING, INC. All rights reserved. This document may not be copied, photocopied,
reproduced, translated, or reduced to any electronic medium or machine-readable form, in whole or in part, without the
prior written consent of OMEGA ENGINEERING, INC.
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Where Do I Find Everything I Need for 
Process Measurement and Control? 

OMEGA…Of Course!
Shop online at omega.com sm

TEMPERATURE
�� Thermocouple, RTD & Thermistor Probes, Connectors, Panels & Assemblies
�� Wire: Thermocouple, RTD & Thermistor
�� Calibrators & Ice Point References
�� Recorders, Controllers & Process Monitors
�� Infrared Pyrometers

PRESSURE, STRAIN AND FORCE
�� Transducers & Strain Gages
�� Load Cells & Pressure Gages
�� Displacement Transducers
�� Instrumentation & Accessories

FLOW/LEVEL
�� Rotameters, Gas Mass Flowmeters & Flow Computers
�� Air Velocity Indicators
�� Turbine/Paddlewheel Systems
�� Totalizers & Batch Controllers

pH/CONDUCTIVITY
�� pH Electrodes, Testers & Accessories
�� Benchtop/Laboratory Meters
�� Controllers, Calibrators, Simulators & Pumps
�� Industrial pH & Conductivity Equipment

DATA ACQUISITION
�� Data Acquisition & Engineering Software
�� Communications-Based Acquisition Systems
�� Plug-in Cards for Apple, IBM & Compatibles
�� Data Logging Systems
�� Recorders, Printers & Plotters

HEATERS
�� Heating Cable
�� Cartridge & Strip Heaters
�� Immersion & Band Heaters
�� Flexible Heaters
�� Laboratory Heaters

ENVIRONMENTAL
MONITORING AND CONTROL
�� Metering & Control Instrumentation
�� Refractometers
�� Pumps & Tubing
�� Air, Soil & Water Monitors
�� Industrial Water & Wastewater Treatment
�� pH, Conductivity & Dissolved Oxygen Instruments
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